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Preface
This preface contains the following information:

• Section P.1 “Important Safety Warnings”
• Section P.2 “Updating BIOS, Drivers, and Software”
• Section P.3 “Finding Information”
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P.1 Important Safety Warnings

WARNING! Avoiding Electrical Shocks. To avoid electrical shock, do not open the power supply. There are no user-
serviceable parts inside. 

To avoid electrical shock and harm to your eyes by laser light, do not open the DVD laser module. The laser module 
should be serviced by service personnel only. Do not attempt to make any adjustment to the laser unit. Refer to the 
label on the DVD for power requirements and wavelength. This product is a class I laser product.

WARNING! Grounding your Equipment. For your safety, always connect the equipment to a grounded wall outlet. 
Always use a power cord with a properly grounded plug, such as the one provided with the equipment, or one in 
compliance with your national safety standards. This equipment can be disconnected from the power by removing the 
power cord from the power outlet. This means the equipment must be located close to an easily accessible power 
outlet.

WARNING! Protecting your Ears. If your system is a multimedia model, or if you have installed a sound card in your 
system, always turn the volume down before connecting the headphones or speakers. This prevents discomfort from 
unexpected noise or static. Listening to loud sounds for prolonged periods of time may permanently damage your 
hearing. Before putting on headphones, place them around your neck and turn the volume down. When you put on 
the headphones, slowly increase the volume until you find a comfortable listening level. When you can hear 
comfortably and clearly, without distortion, leave the volume in that position.

WARNING! Removing and Replacing the Cover. For your safety, never remove the system side cover without first 
disconnecting the power cord from the power outlet and removing any connection to a telecommunications network. If 
a Power Protection Device is fitted to your system, you must shut down your computer using its on/off switch, then 
remove the power cord before removing the system’s side cover. Remove the Power Protection Device cables before any 
servicing operation. Always replace the side cover before switching the system on again.

WARNING! Getting Battery Safety Information. There is a danger of explosion if the battery is incorrectly installed. For 
your safety, never attempt to recharge, disassemble, or burn an old battery. Replace the battery with the same or 
equivalent type, as recommended by the manufacturer. 

The battery in this system is a lithium battery that does not contain any heavy metals. However, to protect the 
environment, do not dispose of batteries in household waste. Return used batteries either to the shop from which you 
bought them, to the dealer from whom you purchased your system, or to HP so that they can either be recycled or 
disposed of in the correct way. Returned batteries will be accepted free of charge.

WARNING! Avoiding Metallic Particulates. They can be especially harmful around electronic equipment. This type of 
contamination may enter the data center environment from a variety of sources, including, but not limited to, raised 
floor tiles, worn air conditioning parts, heating ducts, rotor brushes in vacuum cleaners, or printer component wear. 
Because metallic particulates conduct electricity, they have an increased potential for creating short circuits in 
electronic equipment. This problem is exaggerated by the increasingly dense circuitry of any electronic equipment.

Over time, very fine whiskers of pure metal can form on electroplated zinc, cadmium, or tin surfaces. If these whiskers 
are disturbed, they might break off and become airborne, possibly causing failures or operational interruptions. For 
over 50 years, the electronics industry has been aware of the relatively rare, but possible, threat posed by metallic 
particulate contamination. During recent years, a growing concern has developed in computer rooms where these 
conductive contaminants are formed on the bottom of some raised floor tiles. 

Although this problem is relatively rare, it might be an issue within your computer room. Since metallic contamination 
can cause permanent or intermittent failures on your electronic equipment, Hewlett-Packard strongly recommends that 
your site be evaluated for metallic particulate contamination before installation of electronic equipment. 

WARNING! Avoiding Burn Injuries. Some parts inside the computer will be hot. Turn off and unplug the system, then 
wait approximately three to five minutes for it to cool down before opening the system access panels or touching 
internal components.
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WARNING! Avoiding Electrical Problems with Phone Lines. If you have a modem:

Do not attempt to connect this product to the phone line during a lightning storm. Never install telephone jacks in wet 
locations unless the telephone line has been disconnected at the network interface. Never touch uninsulated telephone 
wires or terminals unless the telephone line has been disconnected at the network interface. Use caution when 
installing or modifying telephone lines. Avoid using a telephone (other than a cordless type) during an lightning storm. 
There may be a risk from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Never touch or remove the communications board without first removing the connection to the telephone network.

CAUTION: Avoiding Static Electricity. Static electricity can damage electronic components. Turn OFF all equipment 
and disconnect the power cable before installing an accessory card. Do not let your clothes touch any accessory card. 
Handle the card as little as possible and with care.

CAUTION: Getting Information on Ergonomic Issues. It is strongly recommended that you read the ergonomics 
information in the Safety and Comfort Guide on the Documentation Library and Diagnostics CD before using your 
system. You can access more extensive ergonomics information at 
http://www.hp.com/ergo.

NOTE: Recycling Your System. HP has a strong commitment toward the environment. Your HP system has been 
designed to respect the environment as much as possible. HP can also take back your old system for recycling when it 
reaches the end of its useful life. HP has a product take-back program in several countries. The collected equipment is 
sent to an HP recycling facilities in Europe or the U.S.A. As many parts as possible are reused. The remainder is 
recycled. Special care is taken for batteries and other potential toxic substances, these are reduced into non-harmful 
components through special chemical processes. If you require more details about the HP product take-back program, 
contact your local dealer or visit http://www.hp.com/hpinfo/globalcitizenship/environment/recycle/.
9
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P.2 Updating BIOS, Drivers, and Software
HP continually strives to implement new enhancements that will increase functionality, performance, and reliability of 
your HP Workstation. To ensure that your system takes advantage of the latest enhancements, HP recommends that you 
install the latest BIOS, driver, and software updates on a regular basis. 

To download available updates, choose one of the following options:

• If you have the Help & Support Center installed on your system (most factory-installed Windows XP operating 
systems do), click Start > Help & Support Center. Click the icon above HP Software & Drivers 
Download and review or select available updates.

• Visit the HP Support Web site:
a. Go to http://www.hp.com/go/workstationsupport.
b. Select your HP Workstation from the list.
c. In the “I would like to” section, click download drivers and software.
d. In the “select operating system” section, select your OS.
e. Locate the BIOS, driver, or software and click download next to your desired file. Follow the on-screen 

instructions to complete installation.

P.3 Finding Information

P.3.1 E-Support
For online access to technical support information and tools, go to http://www.hp.com/support. Support resources 
include Web-based troubleshooting tools, technical knowledge databases, driver and patch downloads, online 
communities, and proactive notification services.

The following sites are also available to you.

• http://www.hp.com—Provides useful product information.
• http://www.hp.com/support/workstation_manuals—Provides the latest online documentation.
• http://www.hp.com/support—Provides a listing of the worldwide technical support phone numbers. Access this 

list by visiting the site, selecting your region and clicking Contact HP in the upper-left corner.

P.3.2 Additional Documentation
Refer to the Documentation Library and Diagnostics CD for additional product information in PDF format. The CD 
contains the following:

• Setup and Troubleshooting guide (available in print and PDF on library CD)—Helps you set up hardware and 
factory-provided software; also includes basic troubleshooting information should you encounter any problems 
during initial startup. 

• Safety and Comfort Guide (PDF on library CD)—Provides safety and ergonomic information to assist you in 
setting up a safe and comfortable workstation environment.

• Safety & Regulatory Information guide (PDF on library CD)—Provides safety and regulatory information that 
ensures compliance with U.S., Canadian, and various international regulations.

P.3.3 Helpful Links
The following links can also be accessed for additional information:

• Product Bulletin—The product bulletin contains the QuickSpecs and is available at:
http://h18000.www1.hp.com/products/quickspecs/productbulletin.html

• For information about the Microsoft® Windows® operating system: http://www.microsoft.com
• For information about the Linux operating system: http://www.redhat.com
• Additional product information is available from the HP Web site at http://www.hp.com/go/workstations.

P.3.4 Using the Documentation Library and Diagnostics CD
To access the contents of the Documentation Library and Diagnostics CD, follow the steps that are applicable to your 
workstation.

Windows-Based Workstations
Insert the CD into the CD-ROM drive. The CD Autorun feature begins.

If there is no CD-ROM drive activity for two minutes or more, the Autorun feature might not be enabled on the 
workstation. To run the CD:
10
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1. Click Start > Run. 
2. In the text box, enter:

X:\index.htm 

(where X is the drive letter designator for the CD-ROM drive)
3. Click OK.

Linux-Based Workstations
If the workstation is running a Linux operating system, browse the CD and click the index.htm file to launch the CD 
interface. To view the documents on the CD, download and install Adobe® Acrobat® Reader for Linux from 
http://www.adobe.com.

P.3.5 Locating Regulatory Information
Refer to the Safety & Regulatory Information guide on the Documentation Library and Diagnostics CD for product class 
information. You can also refer to the label on the rear of the chassis.

P.3.6 Parts and Accessories
For complete and current information on supported accessories and components, visit http://partsurfer.hp.com.

P.3.7 Subscriber’s Choice
Subscriber’s Choice, an HP program, enables you to sign up to receive driver and software alerts, proactive change 
notifications (PCNs), the HP newsletter, and more. Sign up today at http://www.hp.com/go/subscriberschoice.
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1 Product Overview
This chapter presents an overview of the hardware components: 

• Section 1.1 “Product Features”
• Section 1.2 “Serial Number and COA Label Location”
• Section 1.3 “Product Specifications”
• Section 1.4 “Power Supply and Cooling”
• Section 1.5 “Environmental Specifications”
• Section 1.6 “ENERGY STAR”
• Section 1.7 “Hyper-Threading Technology”

For a detailed overview of all hardware components and spare part numbers, visit http://partsurfer.hp.com.
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1.1 Product Features
This section contains the following information:

• Section 1.1.1 “Exploded View”
• Section 1.1.2 “Front Panel Components”
• Section 1.1.3 “Rear Panel Components”

1.1.1 Exploded View
The following illustration shows a typical HP xw4300 Workstation (drive configurations can vary).

For complete information on supported accessories and components, visit http://partsurfer.hp.com.

Table 1-1 Exploded View

1 Power Supply 6 Chassis q System Board

2 Hard Drive 7  Diskette Drive < PCI Express Card

3 Optical Drive* 8 CPU Heatsink = PCI Card

4 Access Panel 9 Processor > Speaker

5 System Fan : Memory Module ? Front Bezel

*An optical drive is a CD-ROM, CD-RW, CD-RW/DVD-ROM, or DVD±RW combo drive.
Product Overview14
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1.1.2 Front Panel Components
The following illustration shows a typical HP xw4300 Workstation. Drive configurations can vary.

Table 1-2 Front Panel View

1 Optical Drive Eject Button 6 Headphone Connector ; Diskette Drive

2 Power On Light 7 Microphone Connector < 5.25-Inch Drive Bays (x2)*

3 Power Button 8 IEEE-1394 Connector** = Optical Drive Activity Light

4 Hard Drive Activity Light 9 Diskette Drive Eject Button*** > Optical Drive*

5 Universal Serial Bus 2.0 (USB) (x2) : Diskette Drive Activity Light***

*An optical drive is a CD-ROM, CD-RW, CD-RW/DVD-ROM, or DVD±RW combo drive.
**IEEE-1394 is an optional feature. If the workstation was purchased without this option, this connector will be covered. 
***Diskette drive is an optional feature.
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1.1.3 Rear Panel Components
The following illustration shows a typical HP xw4300 Workstation. 

Table 1-3 Rear Panel Components

1 Power Supply Built-In Self Test (BIST) LED 9 Graphics Adapter

2 Universal Chass Clamp Opening : Universal Serial Bus 2.0 (USB) (x2)

3 PS/2 Mouse Connector (green) ; Microphone Connector (pink)

4 Parallel Connector (burgundy) < Audio Line-Out Connector (lime)

5 Audio Line-In Connector (light blue) = Universal Serial Bus 2.0 (USB) (x4)

6 RJ-45 Network Connector > Serial Connector (teal)

7 Cable Lock Slot ? PS/2 Keyboard Connector (purple)

8 Padlock Loop @ Power Cord Connector

NOTE: To assist you in connecting your peripheral devices, the rear panel connectors are labeled and color-coded according to 
industry standards.
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1.2 Serial Number and COA Label Location
Each HP Workstation has two unique serial number labels 1 and a Certificate of Authentication (COA) label 2 (for 
Windows-preinstalled systems only). In general, the serial number labels can be found on the top panel or on the side 
of the unit and at the rear of the unit. Keep this number available when contacting customer service for assistance. The 
COA label is generally located on the top panel or side of the unit near the serial number label.

1.3 Product Specifications
The following table lists the physical dimensions of the HP xw4300 Workstation.

Table 1-4 Physical Characteristics

Weight
(dependent on configuration)

16 kg/35 lb (typical configuration)

Tower Dimensions 45.0 cm (17.7 in) high
16.8 cm (6.6 in) wide
45.6 cm (17.9 in) deep
17



1.4 Power Supply and Cooling
This section contains the following information:

• Section 1.4.1 “Power Output and Cooling”
• Section 1.4.2 “Power Supply Specifications”
• Section 1.4.3 “Power Consumption and Cooling”
• Section 1.4.4 “System Fans and Airflow”
• Section 1.4.5 “Resetting the Power Supply”

1.4.1 Power Output and Cooling
The HP xw4300 Workstation power supply contains seven outputs:

• +3.3V—used with PCI, PCI Express, Audio, CK-410, ICH7R, Super I/O, BIOS ROM, and on-board logic 
• +5V—used with storage (disk, optical, 3.5-inch diskette), PCI, PCI Express, ICH7R, Audio, Keyboard/Mouse, 

USB, input to on-board regulators (1.2V, 1.5V, 1.8V), and on-board logic
• +12V-A—used with PCI, PCI Express, and system fans
• +12V-B—used with storage (disk, optical, 3.5-inch diskette, graphics dongle)
• +12VCPU—input to on-board regulator that supplies power for CPU
• -12V—used by PCI
• 5VSB—used for sleep circuitry

WARNING! Do not exceed 110W of a 5V and 3.3V power combination. 

WARNING! Do not exceed 31.5A (378W) of 12V (CPU/A/B) power combination. 

WARNING! Do not exceed 460W of total continuous output power.

1.4.2 Power Supply Specifications
The following table lists the power supply specifications. 

Table 1-5 Max Current per Rail

Voltage Rail Maximum Continuous Current

3.3V 15.0V

5V 21.0V

12VCPU 15.0V

12V-A 10.0V

12V-B 11.0V

V12N 0.3V

5VSB 2.0V

Table 1-6 Power Supply Specifications

Full Ranging Input (No Line Select Switch) Yes

Active Power Factor Correction (APFC)
(Input Current is nearly 1/2 a non-APFC PS)

Yes

Passive Power Factor Correction (PFC) No

Operating Voltage Range 90 to 264VAC/118VAC

Rated Voltage Range 100 to 240VAC

Rated Line Frequency 50 to 60Hz/400Hz

Operating Line Frequency Range 47 to 66Hz/393 to 407Hz

Rated Input Current 7.4A/7.4A

Maximum Rated Power 460W
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1.4.3 Power Consumption and Cooling 
The following table shows the power consumption for a typical configuration based on primary power consumptions:

• One processor (1 x 3.6 GHz 2M L2 Pentium 4 Processor with HT Technology)
• One GB memory (2 x 512 MB)
• Two hard drives (2 x SATA 40 GB)
• CD-ROM drive
• PCI Express Graphics Card (NVIDIA FX 1400)
• One diskette
• Monitor (A monitor is attached. The system does not provide power to the monitor.)

NOTE: To reach zero power consumption, either unplug the workstation from the power outlet or use a power strip with 
a switch. However, removing all power to the workstation might reduce the life of the real-time clock battery.

For more information on power-saving features, refer to your operating system documentation.

1.4.4 System Fans and Airflow
The workstation includes a rear system fan, one processor heatsink fan, one power supply fan, plus an optional front 
system fan.

1.4.5 Resetting the Power Supply
If an overload triggers the power supply overload protection, all power is immediately cut. To reset the power supply unit:

1. Disconnect the power cord.
2. Determine what caused the overload and fix the problem.
3. Reconnect the power cord and reboot the workstation.

When you power down the workstation through the operating system, power consumption falls below the low power 
consumption but does not reach zero. This on/off feature extends the life of the power supply.

Heat Dissipation Typical is 733.8btu/hr
Maximum is 2415.4btu/hr

Power Supply Fan 92mm variable speed

Power Supply Dimensions 9.76cm (3.843 in) wide
15cm (5.906 in) high
15.371cm (6.052 in) deep

ENERGY STAR Compliant Available as an option

Built-in Self Test LED Yes

Surge Tolerant Full Ranging Power Supply Withstands power surges up to 2000V

Table 1-7 HP xw4300 Workstation Power Consumption and Cooling for Specified Configuration

Input Power Consumption 120VAC/60Hz

Typical operating mode (system busy) 215W/733.8btu/hr

Windows XP Idle 107W/365.2btu/hr

Standby mode (S3) ~4W

Hibernate mode (S4) ~3W or less

Power Off (S5) ~3W or less

Table 1-6 Power Supply Specifications
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1.5 Environmental Specifications 
The following table describes the environmental specifications.

Table 1-8 Environmental Specifications

Temperature Operating: 5 to 35°C (40 to 95°F)
Non-operating: -40 to 60°C (-40 to 140°F) 

Humidity Operating: 8 to 85%RH, non-condensing
Non-operating: 8 to 90%RH, non-condensing

Altitude Operating: 0 to 10,000 ft (3048m)
Non-operating: 0 to 30,000 ft (9144m)

Shock Operating ½-sine: 40g, 2-3ms
Non-operating:

½-sine: 160 cm/s, 2-3ms, (~100g)·
square: 605 cm/s, 30 G

NOTE: The values represent individual shock events and are not indicative of repetitive shock 
events.

Vibration Operating Random: 0.5g (rms), 5-300 Hz
Non-Operating:

random: 2.0 g (rms), 10-500 Hz·
NOTE: The values are not indicative of continuous vibration.
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1.6 ENERGY STAR
The ENERGY STAR® program, a government-backed initiative, promotes energy efficiency by identifying ways to reduce 
energy consumption. Select HP Workstations participate in the ENERGY STAR program.

NOTE: ENERGY STAR is not supported on Linux-based workstations.

For those workstations purchased with the Energy Star option and have it enabled, the power management features will 
be set as follows:

• Monitor—goes into sleep mode after 20 minutes of inactivity.
• System—goes into Standby mode after 20 minutes of inactivity.
• Hard Drive—goes into power savings mode after the system goes into Standby mode.

NOTE: If you have to restore the operating system, reset the ENERGY STAR settings (if applicable) after the restore.

To verify the factory default power settings for your product, select Start > Control Panel and double-click Power 
Options.

1.6.1 ENERGY STAR Compliance
HP products purchased with the ENERGY STAR configuration are compliant with the U.S. Environmental Protection 
Agency (EPA) ENERGY STAR Computers Program. The EPA ENERGY STAR configuration does not imply endorsement 
by the EPA. As an ENERGY STAR Partner, HP has determined that products with the ENERGY STAR configuration meet 
the ENERGY STAR guidelines for energy efficiency.

The ENERGY STAR Computers Program was created by the EPA to promote energy efficiency and reduce air pollution 
through more energy-efficient equipment in homes, offices, and factories. HP products achieve this by reducing the 
power consumption when not being used.

ENERGY STAR on HP Workstations uses ACPI power management. The system can wake as a result of a user action 
(keyboard or mouse) or from the network or a modem.

The Power Management feature, when used in conjunction with an external ENERGY STAR-compliant monitor, will 
support the power-down features of the monitor. The Power Management feature allows an external monitor to go into 
low-power mode when the energy save timeout occurs.

CAUTION: Using the Energy Save Monitor feature with non-ENERGY STAR-compliant monitors might cause video 
distortion when the Energy Save timeout occurs.
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1.7 Hyper-Threading Technology
HT Technology is a high performance technology, developed by Intel®, that allows a single processor to execute multiple 
threads of instructions simultaneously. HT Technology enables the Intel processor to utilize its execution resources more 
efficiently, delivering performance increases and improving user productivity. HT Technology is comparable to creating 
two “virtual” processors. It mimics a second core by giving work to under-utilized execution units. However, if there are 
no under-utilized execution units to work with, HT Technology does not provide any benefit, so not all system applications 
benefit from the technology. 

To see if HT Technology can benefit you, test your system by turning the feature on. 

NOTE: If your processor does not support HT Technology, Hyper-Threading will not be an option in the Computer 
Setup (F10) menu.

To enable HT Technology: 

• The Computer Setup (F10) menu can be used to turn this feature on or off. To enter Computer Setup, during 
power up, wait for the prompt F10=setup to appear on the lower right corner of the screen. After the prompt 
appears, press the F10 key to enter F10 setup. At Computer Setup, select Advanced > Device Options > Hyper-
Threading, then choose whether to enable or disable the HT Technology.

OR

• Click the HP Cool Tools icon, select HP Protect Tools Security Manager, select BIOS Configuration, 
click the Advanced tab, click Device Options and enable Hyper-Threading. 
If the HP Cool Tools icon is not on your desktop, click Start > All Programs > HP Cool Tools > HP 
Protect Tools Security Manager. Within HP Protect Tools Security Manager, select BIOS Configuration, 
click the Advanced tab, click Device Options and enable Hyper-Threading.

NOTE: Red Hat Enterprise Linux WS 3 supports HT Technology. An SMP-capable kernel must be installed on your 
system before this technology can be utilized. For information on how to do this, refer to the 
HP User Manual for Linux at www.hp.com/support/linux_user_manual.

For more information about the HT Technology, visit the Intel Web site at www.intel.com.

1.8 Dual-Core CPUs
The HP xw4300 Workstation is the first entry-level workstation to offer an optional dual-core processor. Like HT 
Technology, dual-core processors enable better performance over traditional processors. Dual-core processors contain 
two dedicated processing engines and memory caches that provide the system with two true processors in a single 
socket, rather than the two "virtual" processors provided by HT Technology. Dual-core processors can better handle the 
load of multi-threaded applications (such as rendering an image in Digital Content Creation) and highly multi-tasked 
environments (such as running several productivity applications while listening to music).

1.9 HP Cool Tools
HP xw4300 Workstation comes preloaded with additional software that is not automatically installed when you first 
boot your system. Additionally, a number of valuable pre-installed tools on your workstation can enhance your 
workstation experience. To access or learn more about these applications:

• Open the HP Cool Tools folder by selecting Start > All Programs > HP Cool Tools.

OR

• Click the HP Cool Tools icon on the desktop.

To learn more about these applications, click HP Cool Tools—Learn More.

To install or launch the applications, click the appropriate application.
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2 Installing or Restoring the Operating System
This chapter describes installing and restoring the operating system. 

• Section 2.1 “Installing the Operating System and Software”
• Section 2.2 “HP Software”
• Section 2.3 “Restoring the Operating System”
• Section 2.4 “Protecting the Software”
• Section 2.5 “Ordering Backup Software”

If the workstation was shipped with a preinstalled OS, it is configured automatically the first time the workstation is turned 
on.

CAUTION: Adding optional hardware devices to your workstation before the operating system successfully installs can 
cause errors and prevent the operating system from installing properly.

CAUTION: After the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION UNTIL THIS 
PROCESS COMPLETES. Turning off the workstation during the installation process might damage the software that runs 
the system.
23



2.1 Installing the Operating System and Software
The following section discusses the operating system and HP software installation procedures.

• Section 2.1.1 “Microsoft Windows XP Professional”
• Section 2.1.2 “Installing or Upgrading Device Drivers”
• Section 2.1.3 “Linux-Preinstalled Workstations”
• Section 2.1.4 “Linux-Enabled Workstations”

2.1.1 Microsoft Windows XP Professional
The first time you turn on your workstation, you are prompted to select a language for the operating system. After 
selecting the language, read and follow the instructions on the screen to complete the installation of the operating 
system. This takes approximately 10 minutes, depending on the system hardware configuration. During the process, do 
not turn off your workstation unless you are directed to do so.

2.1.2 Installing or Upgrading Device Drivers
To install hardware devices, such as a printer, display adapter, or network adapter after the operating system is installed, 
the operating system needs access to the appropriate software drivers for the devices. 

To copy the drivers to your system, perform one of the following actions:

• Copy the drivers from the CD that was supplied with the peripheral device because manufacturers usually send 
drivers on the CD. 

• Go to the Help & Support Center installed on your system (on most factory-installed Windows XP operating 
systems), click Start > Help & Support. Click the icon above HP Software & Drivers Download and 
review or select available updates.

• Visit the HP Support Web site:
a. Go to http://www.hp.com/go/workstationsupport.
b. Select your HP Workstation from the list.
c. In the “I would like to” section, click download drivers and software.
d. In the “select operating system” section, select your OS.
e. Locate the driver and click download next to your desired file. Follow the on-screen instructions to 

complete installation.
• Visit the Web site of the manufacturer of the peripheral device if no drivers can be found with the other methods.

Creating a Restore Point
You can use System Restore to undo harmful changes to your computer and restore its settings and performance. System 
Restore returns your computer to an earlier time (called restore point) without causing you to lose recent work, such as 
saved documents, email, or history and favorites list.

To create a restore point for Windows XP, select Start > All Programs > Accessories > System Tools > System 
Restore and follow the on-screen instructions.

2.1.3 Linux-Preinstalled Workstations
If you have a Linux-preinstalled HP Workstation, follow the instructions in this section to set up your OS and software.

After the boot process completes, you can view additional HP Linux documentation by opening your Internet browser 
(the browser is automatically set to use the local HP documentation page as its default). You can also access Linux Web 
links for Red Hat (Internet access required) by using your Internet browser.

NOTE: For additional information on setting up Linux-preinstalled or Linux-enabled workstations, refer to the HP User 
Manual for Linux, which is located at http://www.hp.com/support/linux_user_manual. For more information about HP 
and Linux, visit http://www.hp.com/linux.

Starting the Linux Operating System
The first time the workstation is booted, the Red Hat First Boot utility displays. This program enables you to enter your 
password, network, graphics, time, and keyboard settings for your workstation.

CAUTION: After the automatic installation has begun, DO NOT TURN OFF THE WORKSTATION UNTIL THE PROCESS 
IS COMPLETE. Turning off the workstation during the installation process might damage the software that runs the 
workstation or prevent its proper installation.
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NOTE: When you enable the YPBind feature in the Network tab of the Linux Setup Tool, you might get a blank screen 
for 15–30 seconds after you have selected, saved all of your settings, and have exited the utility. This is normal 
behavior. The boot process continues its execution after the screen returns.

Restoring the Linux Operating System

NOTE: To restore the Linux OS, the HP Driver CD and Red Hat box set are required. To get any new enhancements, 
download the latest HP Driver CD.

NOTE: Linux does not support mixed drive types for a manufacturing preload. When restoring the operating system, 
mixed drive types can be handled with the restoring media.

Downloading the Latest HP Driver CD
1. Download the ISO image to a local hard drive from the HP support Web site at 

http://www.hp.com/go/workstationsupport.
a. Select your HP Workstation from the list.
b. Click download drivers and software.
c. Select the Linux OS that matches your box set.
d. Select the latest version from the Utility Tools section.
e. Download and unpack it (tar zxvf filename.tgz).

2. Copy the ISO image to CD-R bootable media. On another Linux workstation, use the cdrecord utility. Identify the 
device address for the CD burner (cdrecord --scanbus).
The default is usually 2, 0, 0.
Example:
cdrecord -v -eject dev=2,0,0 CD0_golden.iso

Installing with the HP Driver CD
To install with the HP Driver CD:

1. Boot the workstation from the Red Hat box set Binary CD 1.
2. Insert the Linux operating system CDs from the Red Hat box set as prompted.
3. Continue following the prompts until the operating system is successfully installed.
4. Configure the X server to start on reboot.
5. Reboot the workstation.
6. Follow the prompts to set up your system with the Red Hat First Boot utility.
7. When prompted in First Boot to add additional CDs, insert the HP Driver CD into the CD-ROM tray of the 

workstation.
8. Click Install next to “Additional CDs.”

The HP Driver CD window opens.
9. Click Press to begin install...
10. When the install is done, you will have two options, “Reboot now...” on the left side and “Press to continue, 

reboot later...” on the right side. Click Reboot now...

Upgrading Device Drivers
If you must upgrade a Linux device driver, visit the HP Workstation support Web site at
http://www.hp.com/go/workstationsupport.

To install hardware devices, such as a printer, a display adapter, or a network adapter after the operating system is 
installed, the operating system needs access to the appropriate software drivers for the devices. Device drivers are 
usually provided on a CD supplied with the peripheral device.

Some existing peripheral devices might not have been shipped with drivers developed for Linux. To locate the most 
current device drivers:

1. Go to http://www.hp.com/go/workstationsupport.
2. Select your HP Workstation from the list.
3. Click download drivers and software.
4. Select your Linux OS version.
5. Scroll down and download the desired driver.

If no driver is found, visit the Web site of the manufacturer of the peripheral device.
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2.1.4 Linux-Enabled Workstations
Linux-enabled HP Workstations require the HP Installer Kit for Linux and the purchase of a Red Hat box set. The Installer 
Kit includes the HP CDs necessary to complete the installation of all versions of the Red Hat box set that have been 
verified to work on HP Workstation hardware.

Verifying Hardware Compatibility
To see which Linux versions have been verified to work on HP Workstation hardware:

1. Go to http://www.hp.com/support/workstation_manuals.
2. Select your HP Workstation model.
3. Click the Hardware Support Matrix for Linux link.

Installing the Linux Operating System
To install the Linux operating system on your Linux-enabled system:

1. Follow the instructions for “Restoring the Linux Operating System” on page 25 in the previous section.
2. Follow the instructions for “Starting the Linux Operating System” on page 24 in the previous section.

NOTE: For more information on setting up Linux-preinstalled or Linux-enabled HP Workstations, refer to the HP User 
Manual for Linux, which is located at http://www.hp.com/support/linux_user_manual. For more information about HP 
and Linux, visit http://www.hp.com/linux.

Upgrading Device Drivers
If you must install new drivers, go to http://www.hp.com/go/workstationsupport or refer to “Upgrading Device Drivers” 
on page 25 in the previous section for more instructions. 

2.2 HP Software
The following HP software is installed the first time the HP Workstation is turned on:

• Computer Setup (F10) Utilities and diagnostic features
• HP Support Software including device drivers
• HP Client Manager Software (available for download from http://www.hp.com/go/easydeploy)
• System Software Manager (available for download from http://www.hp.com/go/ssm)
• Power Management Setup with Energy Saver features (not supported on Linux)
• Security Management tools
• Software Support Management tools

Certain drivers and utilities are available only in selected languages. You can obtain the latest version of these files, in 
English and selected other languages, in one of four ways:

• Support Software CD
• HP Web site at http://www.hp.com
• Restore Plus! CD, which is supplied with Windows-based workstations
• HP Workstations Red Hat Linux with HP Additions CD, which is supplied with Linux-based workstations

NOTE: Additional HP software might be required in certain situations.

2.3 Restoring the Operating System
To restore the original Windows operating system and factory-installed software, insert the Restore Plus! CD that came 
with your HP Workstation. Carefully read and follow the instructions provided with the Restore Plus! CD.

NOTE: If you restore your system using the Restore Plus! CD, some settings, such as your power management settings 
(such as the Energy Star® settings) will need to be reapplied.

In some scenarios, such as if the system is bootable to Windows, an alternative method is to use the System Restore 
feature included with Windows XP. To restore Windows to a previous state, select Start > All Programs > 
Accessories > System Tools > System Restore and follow the on-screen instructions.

For more information about restoring the Linux OS or software, see “Restoring the Linux Operating System” on page 25.
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2.4 Protecting the Software
To protect software from loss or damage, keep a backup copy of all system software, applications, and related files 
stored on the hard drive. See the operating system or backup utility documentation for instructions on making backup 
copies of data files.

2.5 Ordering Backup Software
All software that shipped with the workstation, including the Restore Plus! CD, can be ordered from HP as a single set, 
or you can order the various software packages separately.

NOTE: Before calling HP to order the software, be sure to have the serial number of the workstation available. See 
“Serial Number and COA Label Location” on page 17.
27
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3 System Management
This section describes the various tools and utilities that allow for the system management of the workstation.

• Section 3.1 “Computer Setup (F10)”
• Section 3.2 “Desktop Management”
29



3.1 Computer Setup (F10)
This section contains the following information to help you use Computer Setup. 

• Section 3.1.1 “BIOS ROM”
• Section 3.1.2 “Using Computer Setup (F10)”
• Section 3.1.3 “Computer Setup Menu”

The Computer Setup (F10) utilities enable you to:

• Change current settings from the factory default settings and set, view, change, or verify the system configuration, 
including settings for processor, graphics, memory, audio, storage, communications, and input devices.

• Determine if all of the devices installed on the workstation are recognized by the system and functioning properly.
• Determine information about the operating environment of the workstation.
• Solve system configuration errors detected but not automatically fixed during the Power-On Self-Test (POST).
• Flash system ROM. 
• Establish and manage passwords and other security features.
• Establish and manage energy-saving timeouts (not supported for Linux platforms).
• Modify or restore factory default settings.
• Set the system date and time.
• Modify the boot order of bootable devices, such as hard drives, diskette drives, optical drives, or LS-120 drives.
• Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run during a Full 

Boot. You can set your system to:
• always Quick Boot (default)
• periodically Full Boot (from every 1 to 30 days)
• always Full Boot

• Enable or disable Network Server Mode, which enables the workstation to boot the operating system when the 
power-on password is enabled with or without a keyboard or mouse attached. When attached to the system, the 
keyboard and mouse remain locked until the power-on password is entered.

• Select POST Messages Enabled or Disabled to change the display status of POST messages. POST Messages 
Disabled suppresses most POST messages, such as memory count, product name, and other non-error text 
messages. If a POST error occurs, the error is displayed regardless of the mode selected. To manually switch to 
POST Messages Enabled during POST, press any key (except F1 through F12).

• Establish an Ownership Tag, the text of which is displayed each time the system is turned on or restarted.
• Enter the Asset Tag or property identification number assigned by your company to this workstation.
• Enable power-on password prompting during system restarts (warm boots) as well as during power-on.
• Secure the integrated I/O functionality, including the serial, USB, or parallel ports, audio, or embedded NIC, so 

that the I/O functionality cannot be used until they are unsecured.
• Enable or disable removable media boot ability.
• Enable or disable removable media write ability (when supported by hardware).
• Replicate your system setup by saving system configuration information on diskette and restoring it on one or 

more workstations.
• Execute self-tests on specified SATA hard drives (when supported by the drive).

3.1.1 BIOS ROM
The Basic Input/Output System (BIOS) of the computer is a collection of machine language programs stored as firmware 
in read-only memory (ROM). The BIOS ROM includes such functions as POST, PCI device initialization, Plug 'n Play (PnP) 
support, power management activities, and the Setup utility. The firmware contained in the BIOS ROM supports the 
following systems and specifications:

• Microsoft WHQL
• Alert-On-LAN (AOL) and Wake-On-LAN (WOL)
• ACPI 1.0 and OnNow
• SMBIOS 2.3.5
• PC98/99/00 and NetPC
• PXE boot ROM for the integrated LAN controller
• BIOS Boot Specification 1.01
• Enhanced Disk Drive Specification 3.0
• “El Torito” Bootable CD-ROM Format Specification 1.0
• ATAPI Removable Media Device BIOS Specification 1.0
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• MPS Specification 1.4 (for booting Linux SMP)

The BIOS ROM is a 1MB Serial Peripheral Interface (SPI) part. The runtime portion of the BIOS resides in a 128-K block 
from E0000h to FFFFFh.

3.1.2 Using Computer Setup (F10)
You can only open Computer Setup by turning on the workstation or restarting the system. To access the Computer Setup 
Utilities menu:

1. Turn on or restart the workstation. 
2. When the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and press the F10 key 
again to access the utility.

3. Select your language from the list and press Enter. 
In the Computer Setup Utilities menu, five headings are displayed: File, Storage, Security, Power, and Advanced.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys to select 
the option you want, then press Enter.

5. To apply and save changes, select File > Save Changes and Exit.
• If you have made changes that you do not want applied, select Ignore Changes and Exit.
• To reset to factory settings, select Apply Defaults and Exit. This option restores the original factory 

system defaults.

CAUTION: Do NOT turn the workstation power OFF while the ROM is saving your Computer Setup F10 changes. If 
you do, the CMOS could become corrupted. After you exit the Computer Setup screen, it is safe to turn off all power to 
the workstation.

3.1.3 Computer Setup Menu

NOTE: This menu can change with new firmware releases, so it might not be consistent with what is presented in the 
following table.

Table 3-1 Computer Setup Menu Descriptions

Heading Option Description

File System Information Lists product name, SKU number, processor type/speed/stepping, cache size (L1/
L2), installed memory size, integrated MAC, system BIOS, chassis serial number, and 
asset tracking number.

About Displays copyright information.

Set Time and Date Enables you to set system time and date.

Flash System ROM Diskette A:
Enables you to upgrade the BIOS when a ROM image is saved on a diskette.
CD-ROM
Enables you to upgrade the BIOS when a ROM image is saved on a CD.

Replicated Setup Save to Removable Media
Saves system configuration, including CMOS, to a formatted, blank 1.44-MB diskette 
in the CPQsetup.txt file. Save/Restore for is supported.

Restore to Removable Media
Restores system configuration from a diskette.

Default Setup Save Current Settings as Default
Saves the current settings as default settings for the next operation.

Restore Factory Settings as Default
Restores the factory settings as the default settings for the next operation.

Apply Defaults and Exit Restores factory default settings, which includes clearing any established passwords.

Ignore Changes and Exit Exits Computer Setup without applying or saving any changes.

Save Changes and Exit Saves changes to system configuration and exits Computer Setup.
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Storage Device Configuration Lists all installed non-SCSI storage devices and provides options for getting specific 
information about each device.
NOTE: SCSI storage drives will not be listed in Computer Setup (F10).

Hard Disk
Provides information about the hard disk drives in the system.

CD-ROM
Provides information about the hard disk drives in the system.

Diskette Type (for legacy diskette drives only)
Identifies the highest capacity media type accepted by the diskette drive. Options are 
3.5" 1.44 MB, 5.25" 1.2 MB, and Not Installed.

Default Values

Multisector Transfers
Options are 8, 16, and Disable. 
Transfer Mode
Specifies the active data transfer mode. Options (subject to device capabilities) are 
Max UDMA, PIO0, Max PIO, Enhanced DMA, and Ultra DMA0
CAUTION: A new Automatic option has been added to allow for BIOS to 
automatically determine the translation mode used to configure a previously formatted 
SATA or USB mass storage device. This prevents you from having to know how the 
mass storage device was previously formatted.
Ordinarily, the translation mode selected automatically by the BIOS should not be 
changed. If the selected translation mode is not compatible with the translation mode 
that was active when the disk was partitioned and formatted, the data on the disk will 
be inaccessible.
Translation Mode
Options are Automatic, Bit Shift, LBA Assisted, Use (Cylinders, Heads, Sectors), and 
Off.

Storage Options Removable Media Boot
Enables/disables ability to boot the system from removable media.

Legacy Diskette Write
Enables/disables ability to write data to removable media.

BIOS DMA Transfers
Enable/disables the BIOS use of DMA for transfers.

SATA Emulation
Options are Separate IDE Controller, Combined IDE Controller, RAID, and AHCI

IDE Controller
Enables/disables primary IDE controller.

Primary SATA Controller
Enables/disables SATA controller #0.

Secondary SATA Controller
Enables/disables SATA controller #1.

DPS Self-test Enables you to select a drive test.

Boot Order TIP: Shortcut to Temporarily Override Boot Order: To boot one time from 
a device other than the default device specified in Boot Order, restart the workstation 
and press F9 when the F10=Setup message appears on the screen. After POST is 
completed, a list of bootable devices is displayed. Use the arrow keys to select the 
preferred bootable device and press Enter. The workstation then boots from the 
selected non-default device for this one time.
NOTE: MS-DOS drive lettering assignments might not apply after a non-MS-DOS 
operating system has started.
Allows you to prioritize the devices boot order. Press Enter to drag a device to a 
preferred place. Press F5 to remove the device from consideration as a bootable 
device. 

Controller Order Allows you to specify the order of the attached hard drive controller. The first hard 
drive controller in the order will have priority in the boot sequence and will be 
recognized as drive C (if any devices are attached).

Table 3-1 Computer Setup Menu Descriptions (continued)

Heading Option Description
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Security Setup Password Allows you to set and enable setup (administrator) password.
NOTE: If the setup password is set, it is required to change Computer Setup options, 
flash the ROM, and make changes to certain PnP settings under Windows.

Power-On Password Allows you to set and enable power-on password.

Smart Cover Allows you to disable cover removal sensor or to notify user if sensor has been 
activated.

Device Security Serial Port
Specifies if device is available or hidden to the OS. 
Parallel Port
Specifies if device is available or hidden to the OS.
All USB Ports
Specifies if device is available or hidden to the OS. 
Front USB Ports
Specifies if device is available or hidden to the OS. 
System Audio
Specifies if device is available or hidden to the OS. 
Network Controller
Specifies if device is available or hidden to the OS. 
Embedded Security Device
Specifies if device is available or hidden to the OS. 

Network Service Boot Enables/disables the ability to boot to the network by way of the F12 key or the boot 
order.

System IDs Allows you to set:
• Asset tag (16-byte identifier) and ownership tag (80-byte identifier displayed 

during POST).
• Universal Unique Identifier (UUID) number, which can only be updated if the 

current chassis serial number is invalid. (These ID numbers are normally set in the 
factory and are used to uniquely identify the system.)

• Keyboard locale setting (for example, English or German) for System ID entry.

Data Execution Prevention Enables/disables a mode that helps prevent OS security breaches.

Table 3-1 Computer Setup Menu Descriptions (continued)

Heading Option Description
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Power OS Power Management Enables/disables ACPI S3 Support, ACPI S3 Hard Disk Reset, ACPI S3 P52 Mouse 
Wakeup, USB Wake on Device Insertion

Hardware Power 
Management

Enables/disables SATA Power Management

Thermal Allows you set the rate of the system fan when CPU is in idle. 

Table 3-1 Computer Setup Menu Descriptions (continued)

Heading Option Description
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Advanced** Power-On Options Allows you to set:
• POST Mode (QuickBoot, FullBoot, or FullBoot every 1–30 days).
• POST Messages (enable/disable).
• F9 Prompt (enable/disable). Enabling this feature will display the text F9=Boot 

Menu during POST. Disabling this feature prevents the text from being displayed. 
However, pressing the F9 key will still access the Shortcut Boot [Order] Menu 
screen.

• F10 Prompt (enable/disable). Enabling this feature displays the text F10=Setup 
during POST. Disabling this feature prevents the text from being displayed but 
pressing F10 still accesses the Setup screen.

• F12 Prompt (enable/disable). Enabling this feature displays the text 
F12=Network Service Boot during POST. Disabling this feature prevents the 
text from being displayed but pressing F12 still forces the system to attempt 
booting from the network.

• Option ROM* prompt (enable/disable). Enabling this feature causes the system 
to display a message before loading options ROMs. 

• Remote Wakeup Boot Source
• After Power Loss (on/off)
• POST Delay (in seconds) (enable/disable). Enabling this feature adds a user-

specified delay to the POST process. This delay is sometimes needed for hard 
disks on some PCI cards that spin up slowly—so slowly that they are not ready to 
boot by the time POST is finished. The POST delay also gives you more time to 
select F10 to enter Computer Setup (F10).

• I/O APIC Mode (enable/disable)
• Limit (PUID Maximum Value to 3) (enable/disable)
• Setup Browse Mode (enable/disable)
• ACPI/USB Buffers @ Top of Memory (enable/disable)

Execute Memory Test The system will reboot and any changes that have been made will be lost. The system 
might boot with memory in a sub-optimal configuration.

BIOS Power-On

Onboard Devices Enables you to set resources for or disable onboard system devices (serial ports, USB 
ports, diskette controllers, and so on).

PCI Devices Enables you to set resources for the following devices:
Intel HD Audio Device (IRQ 5, 10, 11, or disable)
Intel USB Controller (IRQ 5, 10, 11, or disable)
Intel USB Controller (IRQ 5, 10, 11, or disable)
Intel USB Controller (IRQ 5, 10, 11, or disable)
Intel USB Controller (IRQ 5, 10, 11, or disable)
Intel USB Controller (IRQ 5, 10, 11, or disable)
Intel IDE Controller (enable/disable)
Intel SATA Controller (IRQ 5, 10, 11, or disable)
VGA Controller (IRQ 5, 10, 11, or disable)
Broadcom Ethernet Controller (IRQ 5, 10, 11, or disable)

Bus Options The options are:
PCI SERR# Generation (enable/disable)
PCI VGA Palette Snooping (enable/disable)
ECC Support (enable/disable)
Memory Remapping (enable/disable)

Device Options Printer Mode (EPP + ECP, Output-Only, Bi-Directional)
Num Lock State at Power-On (off/on)
S5 Wake-on-LAN (enable/disable)
Processor Cache (enable/disable)
Unique Sleep State Blink Rates (enable/disable)
Monitor Tracking (enable/disable)
NIC PxE Option ROM Download (enable/disable)

Slot 1 (PCI Express x 16) Configures the option ROM.

Slot 2 (PCI) Configures the option ROM and latency timer.

Table 3-1 Computer Setup Menu Descriptions (continued)

Heading Option Description
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Slot 3 (PCI Express x 8’ (x4)) Configures the option ROM.

Slot 4 (PCI Express x1) Configures the option ROM.

Slot 5 PCI Configures the option ROM and latency timer.

Slot 6 PCI Configures the option ROM and latency timer.

*Available on select models.
**These options should be used by advanced users only.

Table 3-1 Computer Setup Menu Descriptions (continued)

Heading Option Description
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3.2 Desktop Management
HP Client Management Solutions (available for download from http://www.hp.com/go/easydeploy) provides 
standards-based solutions for managing and controlling workstations in a networked environment. This section 
summarizes the capabilities and features of the key components of desktop management:

• Section 3.2.1 “Initial Configuration and Deployment”
• Section 3.2.2 “Remote System Installation”
• Section 3.2.3 “Software Updating and Management”
• Section 3.2.4 “ROM Flash”
• Section 3.2.5 “Asset Tracking and Security”
• Section 3.2.6 “Fault Notification and Recovery”

NOTE: Support for specific features described in this section might vary by model or software version.

3.2.1 Initial Configuration and Deployment
The workstation comes with a preinstalled system software image. After a brief software “unbundling” process, the 
workstation is ready to use.

You might prefer to replace the preinstalled software image with a customized set of system and application software. 
There are several methods for deploying a customized software image. They include:

• Installing additional software applications after unbundling the preinstalled software image.
• Using software deployment tools, such as Altiris Deployment Solutions™, to replace the preinstalled software with 

a customized software image.
• Using a disk-cloning process to copy the contents from one hard drive to another.

The best deployment method depends on your information technology environment and processes. The PC Deployment 
section of the HP Lifecycle Solutions Web site (http://whp-sp-orig.extweb.hp.com/country/us/en/solutions.html) 
provides information to help you select the best deployment method.

The Restore Plus! CD-ROM-based setup and ACPI hardware provide further assistance with recovery of system software, 
configuration management and troubleshooting, and power management.

3.2.2 Remote System Installation
Remote System Installation lets you start and set up your system using the software and configuration information located 
on a network server. This feature is usually used as a system setup and configuration tool, and can be used for the 
following tasks:

• Deploying a software image on one or more new PCs
• Formatting a hard drive
• Installing application software or drivers
• Updating the operating system, application software, or drivers

To initiate Remote System Installation, press F12 when the F12=Network Service Boot message appears in the 
lower-right corner of the HP logo screen. Follow the on-screen instructions to continue the process. The default boot order 
is a BIOS configuration setting that can be changed to always attempt to PXE boot.

HP and Altiris have partnered to provide tools designed to make the task of corporate PC deployment and management 
easier and less time-consuming, ultimately lowering the total cost of ownership and making HP PCs the most 
manageable client PCs in the enterprise environment.

3.2.3 Software Updating and Management
HP provides several tools for managing and updating software on desktops and workstations—HP Client Manager 
Software, Altiris Client Management Solutions, System Software Manager, Proactive Change Notification, and 
Subscriber’s Choice.

HP Client Manager Software
HP Client Manager Software (HP CMS) assists HP customers in managing the hardware aspects of their client 
workstations with features that include:

• Detailed views of hardware inventory for asset management
• PC health check monitoring and diagnostics
• Proactive notification of changes in the hardware environment
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• Web-accessible reporting of business critical details, such as machines with thermal warnings, memory alerts, 
and more

• Remote updating of system software such as device drivers and ROM BIOS
• Remote changing of boot order
• Configuring the system BIOS settings

For more information on the HP Client Manager, visit http://www.hp.com/go/im.

Altiris Client Management Solutions
HP and Altiris have partnered to provide comprehensive, tightly integrated systems management solutions to reduce the 
cost of owning HP client PCs. HP Client Manager Software is the foundation for additional Altiris Client Management 
Solutions that address:

• Inventory and Asset Management
• SW license compliance
• PC tracking and reporting
• Lease contract, fixing asset tracking

• Deployment and Migration
• Microsoft Windows XP Professional or Home Edition migration
• System deployment
• Personality migrations

• Help Desk and Problem Resolution
• Managing help desk tickets
• Remote troubleshooting
• Remote problem resolution
• Client disaster recovery

• Software and Operations Management
• Ongoing desktop management
• HP system SW deployment
• Application self-healing

For more information and details on how to download a fully-functional 30-day evaluation version of the Altiris solutions, 
visit http://h18000.www1.hp.com/im/prodinfo.html#deploy.

For more information, visit http://www.hp.com/go/easydisplay.

System Software Manager
System Software Manager (SSM) is a utility that lets you update system-level software on multiple systems simultaneously. 
When executed on a PC client system, SSM detects both hardware and software versions, then updates the appropriate 
software from a central repository, also known as a file store. Driver versions that are supported by SSM are denoted 
with a special icon on the software, the driver download Web site, and on the Support Software CD. To download the 
utility or to obtain more information on SSM, visit http://www.hp.com/go/ssm.

Proactive Change Notification
The Proactive Change Notification program uses the Subscriber's Choice Web site to proactively and automatically:

• Send you Proactive Change Notification (PCN) e-mails informing you of hardware and software changes to most 
commercial workstations and servers, up to 60 days in advance.

• Send you e-mail containing Customer Bulletins, Customer Advisories, Customer Notes, Security Bulletins, and 
Driver alerts for most commercial workstations and servers.

You create your own profile to ensure that you only receive the information relevant to a specific IT environment. To learn 
more about the Proactive Change Notification program and create a custom profile, visit 
http://www.hp.com/go/pcn.

Subscriber’s Choice
Subscriber’s Choice is a client-based service from HP. Based on your profile, HP will supply you with personalized 
product tips, feature articles, driver and support alerts/notifications, or both. Subscriber’s Choice Driver and Support 
Alerts/Notifications will deliver e-mails notifying you that the information you subscribed to in your profile is available 
for review and retrieval. To learn more about Subscriber’s Choice and create a custom profile, visit 
http://www.hp.com/go/pcn.
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3.2.4 ROM Flash
The workstation comes with a programmable read-only memory (ROM), also known as flash memory. By establishing 
a setup password in the Computer Setup (F10) Utility, you can protect the ROM from being unintentionally updated or 
overwritten. This is important to ensure the operating integrity of the workstation. If you need or want to upgrade the 
ROM, you can:

• Order an upgraded ROMPaq diskette from HP.
• Download the latest ROMPaq images from HP driver and support page: http://www.hp.com/support/files.

CAUTION: For maximum ROM protection, be sure to establish a setup password. The setup password prevents 
unauthorized ROM upgrades. System Software Manager allows the system administrator to set the setup password on 
one or more PCs simultaneously. For more information, visit http://www.hp.com/go/ssm.

CAUTION: The boot block jumper MUST NOT be installed during a ROM flash operation unless specified by HP. 
Normally, the boot block jumper is completely removed or installed only on pin 2. Installing the boot block jumper 
enables changing the boot block and defeats the FailSafe Boot Block ROM protection.

Remote ROM Flash
Remote ROM Flash allows the system administrator to safely upgrade the ROM on remote HP workstations directly from 
the centralized network management console. Enabling the system administrator to perform this task remotely on 
multiple workstations and personal computers results in a consistent deployment of and greater control over HP PC ROM 
images over the network. It also results in greater productivity and lower total cost of ownership.

The workstation must be powered on to take advantage of Remote ROM Flash.

For more information on Remote ROM Flash, see the HP Client Manager Software or System Software Manager at 
http://h18000.www1.hp.com/im/prodinfo.html.

HPQFlash
The HPQFlash utility is used to locally update or restore the system ROM on individual PCs through a Windows operating 
system.

For more information on HPQFlash, visit http://www.hp.com/support/files and enter the name of the workstation when 
prompted.

FailSafe Boot Block ROM
The FailSafe Boot Block ROM allows for system recovery in the unlikely event of a ROM flash failure; for example, if a 
power failure were to occur during a ROM upgrade. The Boot Block is a flash-protected section of the ROM that checks 
for a valid system ROM flash when power to the system is turned on.

• If the system ROM is valid, the system starts normally.
• If the system ROM fails the validation check, the FailSafe Boot Block ROM provides enough support to start the 

system from a ROMPaq diskette, which will program the system ROM with a valid image.

NOTE: Some models also support recovery from a ROMPaq CD. ISO ROMPaq images are included with selected 
models in the downloadable ROM softpaqs.

When the boot block detects an invalid system ROM, the system beeps and the power LED blinks RED eight times. A 
Boot Block recovery mode message is displayed on the screen (some models).

To recover the system after it enters Boot Block recovery mode:

1. If there is a diskette in the diskette drive or a CD in the CD drive, remove the diskette and CD and turn off the 
power.

2. Insert a ROMPaq diskette into the diskette drive or, if permitted on this workstation, a ROMPaq CD into the CD 
drive.

3. Turn on the workstation.
If no ROMPaq diskette or ROMPaq CD is found, you will be prompted to insert one and restart the workstation.
If a setup password has been established, the Caps Lock light will turn on (on PS/2 keyboard only) and you will 
be prompted to enter the password.

4. Enter the setup password.
If the system successfully starts from the diskette and successfully reprograms the ROM, then the three keyboard 
lights will turn on. A rising tone series of beeps also signals successful completion.

5. Remove the diskette or CD and turn the power off.
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6. Turn the power on again to restart the workstation.

The following table lists the various keyboard light combinations used by the Boot Block ROM (when a PS/2 keyboard 
is attached to the workstation), and explains the meaning and action associated with each combination.

Replicating the Setup
The following procedures give an administrator the ability to easily copy one setup configuration to other workstations 
of the same model. This allows for faster, more consistent configuration of multiple workstations.

NOTE: Both procedures require a diskette drive.

NOTE: To collect and replicate BIOS settings on multiple computers, use System Software Manager or HP Client 
Manager Software. For more information, visit http://www.hp.com/go/easydeploy.

Copying to a Single Workstation

CAUTION: A setup configuration is model-specific. File system corruption might result if source and target workstations 
are not the same model. For example, do not copy the setup configuration from an HP xw4200 Workstation to an HP 
xw4300 Workstation.

1. Select a setup configuration to copy. Turn off the workstation. 
2. Turn on the workstation.
3. When the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

4. If you are using a diskette, insert it now.
5. Click File > Save to Diskette. Follow the instructions on the screen to create the configuration diskette.
6. Turn off the workstation to be configured and insert the configuration diskette.
7. Turn on the workstation to be configured.
8. When the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

9. Click File > Restore from Diskette and follow the on-screen instructions.
10. Restart the workstation when the configuration is complete.

Copying to Multiple Workstations

CAUTION: A setup configuration is model-specific. File system corruption might result if source and target workstations 
are not the same model. For example, do not copy the setup configuration from a HP Workstation xw4200 to HP 
xw4300 Workstation.

This method takes a little longer to prepare the configuration diskette, but copying the configuration to target 
workstations is significantly faster.

NOTE: A bootable diskette is required for this procedure. If Windows XP is not available to create a bootable diskette, 
use the method for copying to a single workstation instead (see “Copying to a Single Workstation” on page 40).

Table 3-2 Keyboard Light Combinations Used by Boot Block ROM

FailSafe Boot
Block Mode

Keyboard LED Activity State/Message

Num Lock On ROMPaq diskette or ROMPaq CD not present, is bad, or drive not ready.

Caps Lock On Enter password.

Num, Caps, Scroll 
Lock

Blink On in sequence, one 
at a time–N,C, SL

Keyboard locked in network mode.

Num, Caps, Scroll 
Lock

On Boot Block ROM Flash successful. Turn power off, then on to reboot.

NOTE: Diagnostic lights do not flash on USB keyboards
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1. Create a bootable diskette. 
2. Select a setup configuration to copy. 
3. Download a BIOS utility for replicating setup (repset.exe) and copy it onto the configuration diskette. To obtain 

this utility, go to http://welcome.hp.com/support/files and enter the model number of the workstation.
4. On the configuration diskette, create an autoexec.bat file containing the following command: repset.exe.
5. Restart the workstation.
6. When the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

7. Insert the diskette now.
8. Click File > Replicated Setup > Save to Diskette. Follow the on-screen instructions to create the 

configuration diskette.
9. Turn off the workstation to be configured. Insert the configuration diskette and turn the workstation on. The 

configuration utility will run automatically.
10. Restart the workstation when the configuration is complete.

Dual-State Power Button
With Advanced Configuration and Power Interface (ACPI) enabled, the power button can function either as an on/off 
switch or as a Standby button. The Standby feature does not completely turn off power, but instead causes the 
workstation to enter a low-power standby state. This allows you to power down quickly without closing applications and 
to return quickly to the same operational state without any data loss.

To change the power button configuration:

1. Click Start > Control Panel > Power Options.
2. In the Power Options Properties, select the Advanced tab.
3. In the Power Button section, select Standby.

After configuring the power button to function as a Standby button, press the power button to put the system in a very 
low power state (Standby). Press the button again to quickly bring the system out of Standby to full power status. To 
completely turn off all power to the system, press and hold the power button for four seconds.

CAUTION: Do not use the power button to turn off the workstation unless the system is not responding; turning off the 
power without operating system interaction could cause damage to or loss of data on the hard drive.

World Wide Web Site
HP engineers rigorously test and debug software developed by HP and third-party suppliers, and develop operating 
system specific support software, to ensure performance, compatibility, and reliability for HP workstations.

When making the transition to new or revised operating systems, it is important to implement the support software 
designed for that operating system. If you plan to run a version of Microsoft Windows that is different from the version 
included with the workstation, you must install corresponding device drivers and utilities to ensure that all features are 
supported and functioning properly.

HP has made the task of locating, accessing, evaluating, and installing the latest support software easier. You can 
download the software from http://www.hp.com/support.

The Web site contains the latest device drivers, utilities, and flashable ROM images needed to run the latest Microsoft 
Windows operating system on the HP workstation.

Building Blocks and Partners
HP management solutions integrate with other systems management applications, and are based on industry standards, 
such as:

• Web-Based Enterprise Management (WBEM)
• Windows Management Interface (WMI)
• Wake on LAN Technology
• ACPI
• SMBIOS
• Pre-boot Execution (PXE) support
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3.2.5 Asset Tracking and Security
Asset tracking features incorporated into the workstation provide key asset tracking data that can be managed using 
HP Systems Insight Manager, HP Client Manager Software, or other system management applications. Seamless, 
automatic integration between asset tracking features and these products enables you to choose the management tool 
that is best suited to the environment and to leverage the investment in existing tools.

HP also offers several solutions for controlling access to valuable components and information. ProtectTools Embedded 
Security, if installed, prevents unauthorized access to data and checks system integrity and authenticates third-party users 
attempting system access. Security features, such as ProtectTools and the Hood Sensor (Smart Cover Sensor) help to 
prevent unauthorized access to the internal components of the workstation. By disabling parallel, serial, or USB ports, 
or by disabling removable media boot capability, you can protect valuable data assets. Memory Change and Hood 
Sensor (Smart Cover Sensor) alerts can be automatically forwarded to system management applications to deliver 
proactive notification of tampering with a workstation’s internal components.

NOTE: ProtectTools, the Hood Sensor (Smart Cover Sensor), and the Hood Lock (Smart Cover Lock) are available as 
options on select systems.

Use the following utilities to manage security settings on the HP Workstation:

• Locally, using the Computer Setup Utilities. 
• Remotely, using HP Client Manager Software or System Software Manager. This software enables the secure, 

consistent deployment and control of security settings from a simple command-line utility.

The following table and sections refer to managing security features of the workstation locally through the Computer 
Setup (F10) Utilities.

Password Security
The power-on password prevents unauthorized use of the workstation by requiring entry of a password to access 
applications or data each time the workstation is turned on or restarted. The setup password specifically prevents 
unauthorized access to Computer Setup, and can also be used as an override to the power-on password. That is, when 
prompted for the power-on password, entering the setup password instead will allow access to the workstation.

A network-wide setup password can be established to enable the system administrator to log in to all network systems 
to perform maintenance without having to know the power-on password.

NOTE: System Software Manager and HP Client Manager Software allow remote management of Setup Passwords 
and other BIOS settings in a networked environment. For more information, visit 
http://www.hp.com/go/easydeploy.

Establishing a Setup Password Using Computer Setup
Establishing a setup password through Computer Setup prevents reconfiguration of the workstation (use of the Computer 
Setup (F10) utility) until the password is entered.

To establish a setup password using computer setup:

1. Turn on or restart the workstation. 
2. As soon as the computer is turned on, press and hold the F10 until you enter Computer Setup. Press Enter to 

bypass the title screen, if necessary.

Table 3-3 Security Features Overview

Feature Purpose How It Is Established

Removable Media Boot Control Prevents booting from the removable media 
drives.

From the Setup Utilities menu.

Serial, USB, 1394, network, or 
SCSI Interface Control

Prevents transfer of data through the integrated 
serial, USB, or infrared interface.

From the Setup Utilities menu.

Power-On Password Prevents use of the workstation until the 
password is entered. This can apply to both 
initial system startup and restarts.

From the Setup Utilities menu.

Setup Password Prevents reconfiguration of the workstation (use 
of the Setup Utilities) until the password is 
entered.

From the Setup Utilities menu.

Network Server Mode Provides unique security features for 
workstations being used as servers.

From the Setup Utilities menu.

For more information about Computer Setup, refer to “Computer Setup Menu” on page 31.
System Management42

www.hp.com/go/EasyDeploy


Sy
ste

m
 M

an
ag

em
en

t 
NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and press and hold the 
F10 key again to access the utility.

If you are using a PS/2 keyboard, you might see a Keyboard Error message—disregard it.

3. Select Security > Setup Password and follow the on-screen instructions.
4. Before exiting, select File > Save Changes and Exit.

Establishing a Power-On Password Using Computer Setup
Establishing a power-on password through Computer Setup prevents access to the workstation when power is turned on, 
unless the password is entered. When a power-on password is set, Computer Setup presents Password Options under 
the Security menu. The password options include Network Server Mode and Password Prompt on Warm Boot.

When Network Server Mode is disabled, the password must be entered each time the workstation is turned on when 
the key icon appears on the monitor. When Password Prompt on Warm Boot is enabled, the password must also be 
entered each time the workstation is rebooted. When Network Server Mode is enabled, the password prompt is not 
presented during POST, but any attached PS/2 keyboard will remain locked until the user enters the power-on computer.

To establish a power-on password through Computer Setup:

1. Turn on or restart the workstation. 
2. As soon as the computer is turned on, press and hold the F10 until you enter Computer Setup. Press Enter to 

bypass the title screen, if necessary.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and press and hold the 
F10 key again to access the utility.

If you are using a PS/2 keyboard, you might see a Keyboard Error message—disregard it.

3. Select Security > Power-On Password and follow the on-screen instructions.
4. Before exiting, select File > Save Changes and Exit.

Entering a Power-On Password
To enter a power-on password:

1. Turn on or restart the workstation. 
2. When the key icon appears on the monitor, enter the current password, then press Enter.

NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you must turn 
off the workstation, then turn it on again before you can continue.

Entering a Setup Password
If a setup password has been established on the workstation, you will be prompted to enter it each time you run 
Computer Setup.

To enter a setup password:

1. Turn on or restart the workstation. 
2. When the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

3. When the key icon appears on the monitor, enter the setup password, then press Enter.

NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

If you enter the password incorrectly, a broken key icon appears. Try again. After three unsuccessful tries, you must turn 
off the workstation, then turn it on again before you can continue.

Changing a Power-On or Setup Password
To change a power-on or setup password:

1. Turn on or restart the workstation. To change the setup password, run Computer Setup.
2. To change the Power-On password, go to step 3.
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To change the Setup password, when the F10=Setup appears on the screen, press the F10 key to enter the 
utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

3. When the key icon appears, type the current password, a slash (/) or alternate delimiter character, your new 
password, another slash (/) or alternate delimiter character, and your new password again as shown:

current password/new password/new password

NOTE: Type carefully. For security reasons, the characters you enter do not appear on the screen.

4. Press Enter.

The new password takes effect the next time you turn on the workstation.

NOTE: See the “National Keyboard Delimiter Characters” on page 44 for information about the alternate delimiter 
characters. The power-on password and setup password can also be changed using the Security options in Computer 
Setup.

Deleting a Power-On or Setup Password
To delete a power-on or setup password:

1. Turn on or restart the workstation. 
2. To delete the Power-On password, go to Step 3.

To delete the Setup Password, when the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

When the key icon appears, enter your current password followed by a slash (/) or alternate delimiter character 
as shown:

current password/

3. Press Enter.

NOTE: See the “National Keyboard Delimiter Characters” on page 44 section for information about the alternate 
delimiter characters. The power-on password and setup password can also be changed using the Security options in 
Computer Setup.

National Keyboard Delimiter Characters
Each keyboard is designed to meet country-specific requirements. The syntax and keys that you use for changing or 
deleting your password depend on the keyboard that came with your workstation.

Table 3-4 National Keyboard Delimiter Characters

Arabic / Greek - Russian /

Belgian = Hebrew . Slovakian -

BHCSY* - Hungarian - Spanish -

Brazilian / Italian - Swedish/Finnish /

Chinese / Japanese / Swiss -

Czech - Korean / Taiwanese /

Danish - Latin 
American

- Thai /

French ! Norwegian - Turkish .

French 
Canadian

é Polish - U.K. English /

German - Portuguese - U.S. English /

*For Bosnia-Herzegovina, Croatia, Slovenia, and Yugoslavia
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Clearing Passwords
If you forget your password, you cannot access the workstation. Refer to “Additional Password Security and Resetting 
CMOS” on page 147 for instructions on clearing passwords.

Hood Sensor (Smart Cover Sensor)
The hood sensor is a combination of hardware and software technology that can alert you when the workstation side 
access panel has been removed. This feature is sold with the Solenoid Hood (Smart Cover) Lock. There are three levels 
of protection, as described in the following table.

Setting the hood sensor protection level 
To set the hood sensor protection level:

1. Turn on or restart the workstation.
2. When the F10=Setup appears on the screen, press the F10 key to enter the utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again.

3. Select Security > Smart Cover > Cover Removal Sensor, then side access panel, and follow the on-
screen instructions.

4. Before exiting, click File > Save Changes and Exit.

Solenoid Hood (Smart Cover) Lock
The solenoid hood lock is available as an option on HP Workstation xw4300 models (this option comes as a kit that 
includes the hood sensor). When installed, the solenoid hood lock can prevent unauthorized access to the internal 
components. This kit is sold with the Hood Sensor. 

CAUTION: For maximum cover lock security, be sure to establish a setup password. The setup password prevents 
unauthorized access to the Computer Setup utility.

Locking the Solenoid Hood Lock
To activate and lock the solenoid hood lock:

1. Turn on or restart the workstation.
2. Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the prompt, 

press the F10 key to enter the F10 setup utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again to 
access the utility. 

3. Select Security > Smart Cover > Cover Lock > Lock option.
4. Before exiting, select File > Save Changes and Exit.

Unlocking the Solenoid Hood Lock
To unlock the solenoid hood lock:

1. Turn on or restart the workstation. 
2. Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the prompt, 

press the F10 key to enter the F10 setup utility.

Table 3-5 Hood Sensor Protection Levels

Level Setting Description

Level 0 Disable Hood sensor is disabled (default).

Level 1 Notify User When the workstation is restarted, the screen displays a message 
indicating that the workstation side access panel has been 
removed.

Level 2 Password When the workstation is restarted, the screen displays a message 
indicating that the workstation access panel has been removed. 
You must enter the setup password to continue.
This option is only available if an administrator password is set. 

NOTE: These settings can be changed using Computer Setup. 
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NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again to 
access the utility. 

3. Select Security > Smart Cover > Cover Lock > Unlock.
4. Before exiting, select File > Save Changes and Exit.

Using the Access Panel Failsafe Key
If you enable the solenoid hood lock and cannot enter your password to disable the lock, you will need an access panel 
FailSafe Key to open the workstation access panel. You will need the key in any of the following circumstances:

• Power outage
• Startup failure
• PC component failure (such as processor or power supply)
• Forgotten password

CAUTION: The access panel FailSafe Key (T-15 wrench) is a specialized tool available from HP. It is beneficial to order 
this key before you need one.

To obtain the FailSafe Key, complete any one of the following tasks:

• Contact your authorized HP reseller or service provider.
• Visit the HP Web site (http://www.hp.com) for ordering information.
• Visit the Contact HP Worldwide Web site (http://welcome.hp.com/country/us/en/wwcontact.html) for contact 

information.

Cable Lock Slot 
The rear panel of the chassis can accommodate a cable lock accessory that allows the workstation to be physically 
secured to a work area and prevents access panel from being removed.

Padlock Loop (Optional)
Prevents access panel from being removed. This loop can also be used to secure the unit to a fixed object.

Universal Chassis Clamp Lock (Optional)
The version without a cable discourages access panel removal and prevents theft of I/O devices. The version with a 
cable also prevents entire system theft and allows multiple systems to be secured with a single cable.

Master Boot Record Security
The MBR contains information needed to successfully boot from a disk and to access the data stored on the disk. Master 
Boot Record Security detects and reports unintentional or malicious changes to the MBR, such as those caused by some 
workstation viruses or by the incorrect use of certain disk utilities. It also allows you to recover the “last known good” 
MBR, should changes to the MBR be detected when the system is restarted.

To enable MBR Security:

1. Turn on or restart the workstation. 
2. Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the prompt, 

press the F10 key to enter the F10 setup utility.

NOTE: If you do not press the F10 key at the appropriate time, you must restart the workstation and try again to 
access the utility. 

3. Select Security > Master Boot Record Security > Enabled.
4. Select Security > Save Master Boot Record.
5. Before exiting, select File > Save Changes and Exit.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current bootable 
disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot prevent 
changes that might occur while the operating system is running.

Each time the workstation is turned on or restarted, the BIOS compares the MBR of the current bootable disk to the 
previously saved MBR. If changes are detected and if the current bootable disk is the same disk from which the MBR 
was previously saved, the following message is displayed:
System Management46

www.hp.com
http://welcome.hp.com/country/us/en/wwcontact.html


Sy
ste

m
 M

an
ag

em
en

t 
1999 - Master Boot Record has changed.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

• Save the MBR of the current bootable disk
• Restore the previously saved MBR
• Disable the MBR Security feature

You must know the setup password, if one exists.

If changes are detected and if the current bootable disk is not the same disk from which the MBR was previously saved, 
the following message is displayed:

2000 - Master Boot Record Hard Drive has changed.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

• Save the MBR of the current bootable disk
• Disable the MBR Security feature

You must know the setup password, if one exists.

In the unlikely event that the previously saved MBR has been corrupted, the following message is displayed:

1998 - Master Boot Record has been lost.
Press any key to enter Setup to configure MBR Security.

Upon entering Computer Setup, you must perform one of the following tasks:

• Save the MBR of the current bootable disk
• Disable the MBR Security feature

You must know the setup password, if one exists.

Before You Partition or Format the Current Bootable Disk
Before you partition or format the current bootable disk, ensure that MBR Security is disabled before you change 
partitioning or formatting of the current bootable disk. Some disk utilities, such as FDISK and FORMAT, attempt to update 
the MBR. If MBR Security is enabled when you change partitioning or formatting of the disk, you might receive error 
messages from the disk utility or a warning from MBR Security the next time the workstation is turned on or restarted.

To disable MBR Security:

1. Turn on or restart the workstation. 
2. Wait for the F10=Setup prompt to appear on the lower right corner of the screen. Once you see the prompt, 

press the F10 key to enter the F10 setup utility.

NOTE: If you do not press F10 key at the appropriate time, you must restart the workstation and try again to access 
the utility. 

3. Select Security > Master Boot Record Security > Disabled.
4. Before exiting, select File > Save Changes and Exit.

Rear Port Controller Cover (Optional)
Clips to the back of the workstation and secures your I/O devices and prevents any cables at the back of the workstation 
from being removed.

3.2.6 Fault Notification and Recovery
Fault Notification and Recovery features combine innovative hardware and software technology to prevent the loss of 
critical data and minimize unplanned downtime.

If the workstation is connected to a network managed by HP Client Manager Software, the computer sends a fault notice 
to the network management application. With HP Client Manager Software, you can also remotely schedule diagnostics 
to automatically run on all managed PCs and create a summary report of failed tests.

Drive Protection System
The DPS is a diagnostic tool built into the hard drives installed in select HP workstations. DPS is designed to help 
diagnose problems that might result in unwarranted hard drive replacement.
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When HP workstations are built, each installed hard drive is tested using DPS, and a permanent record of key 
information is written onto the drive. Each time DPS is run, test results are written to the hard drive. The service provider 
can use this information to help diagnose conditions that caused you to run the DPS software. 

ECC Fault Prediction and Prefailure Warranty
When the workstation encounters an excessive number of error checking and correcting (ECC) memory errors, the 
workstation displays a Local Alert message. This message contains detailed information about the errant memory 
module, allowing you to take action before you experience non-correctable memory errors. The Prefailure Warranty for 
ECC memory modules allows you to replace these modules, free of charge, before the modules actually fail. ECC 
memory modules are optional on selected HP systems.

NOTE: To use this feature, you must replace the standard DIMMs with HP ECC DIMMs.

Surge-Tolerant Power Supply
An integrated surge-tolerant power supply provides greater reliability when the workstation is hit with an unpredictable 
power surge. This power supply is rated to withstand a power surge of up to 2000V (Line to PE or Neutral to PE) and 
1000V (Line to Line) without any data loss or system downtime.

Thermal Sensor
The thermal sensors are hardware and software features that track the internal temperature of the workstation. Based on 
those readings, the sensors influence the speed of the internal fans. The sensors can also cause the system to execute 
slowly or shut down when predetermined temperature limits are exceeded. When combined with HP Client Manager 
Software, this feature notifies the network administrator when the normal range is exceeded. 
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4 Removal and Replacement Procedures
This chapter describes removal and replacement procedures of most internal components.

• Section 4.1 “Service Considerations”
• Section 4.2 “Pre-Disassembly Procedures”
• Section 4.3 “System Board”
• Section 4.4 “Steps for Removal and Replacement of Components”
• Section 4.5 “Disassembly Order”
• Section 4.6 “Security Lock (Optional)”
• Section 4.7 “Cable Lock (Optional)”
• Section 4.8 “Universal Chassis Clamp Lock (Optional)”
• Section 4.9 “Access Panel”
• Section 4.10 “Hood Sensor”
• Section 4.11 “Solenoid Hood (Smart Cover) Lock (Optional)”
• Section 4.12 “Front Bezel”
• Section 4.13 “Bezel Blanks”
• Section 4.14 “Front Panel I/O Device Assembly”
• Section 4.15 “Power Button”
• Section 4.16 “System Speaker”
• Section 4.17 “Power Supply”
• Section 4.18 “System Fan”
• Section 4.19 “Memory”
• Section 4.20 “Peripheral Component Interconnect (PCI) Slots”
• Section 4.21 “Front Fan (Optional)”
• Section 4.22 “Battery”
• Section 4.23 “Power Connections”
• Section 4.24 “Optical Drive (Minitower Position)”
• Section 4.25 “Optical Drive (Desktop Position)”
• Section 4.26 “Diskette Drive”
• Section 4.27 “SCSI Hard Disk Drive”
• Section 4.28 “SATA Hard Drive”
• Section 4.29 “CPU Heatsink”
• Section 4.30 “Processor”
• Section 4.31 “System Board”
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4.1 Service Considerations
The following sections discuss service considerations that should be reviewed and practiced before removing and 
replacing any system components.

WARNING! When lifting or moving the workstation, do not use the front bezel as a handle or lifting point. Lifting the 
workstation from the front bezel or lifting it incorrectly can cause the unit to fall and harm the user and damage the 
workstation. To properly and safely lift the workstation, lift it from the bottom of the unit.

• Section 4.1.1 “Cautions, Warnings, and Safety Precautions”
• Section 4.1.2 “Electrostatic Discharge Information”
• Section 4.1.3 “Tools and Software Requirements”
• Section 4.1.4 “Special Handling of Components”

4.1.1 Cautions, Warnings, and Safety Precautions
For your safety, you must review the “Important Safety Warnings” on page 8 before accessing the components of the 
workstation. Also, review the Safety and Regulatory Guide that came with your workstation for more information.

WARNING! Avoid Burn Injuries. Some parts inside the computer will be hot. Turn off and unplug the system, then wait 
approximately three to five minutes for them to cool down before opening the system access panels or touching internal 
components.

4.1.2 Electrostatic Discharge Information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device exposed to electrostatic 
discharge (ESD) might not appear to be affected at all and can work perfectly throughout a normal cycle. The device 
can function normally for a while, but it has been degraded in the internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge contains enough 
power to alter device parameters or melt silicon junctions.

Generating Static
The following table shows that:

• Different activities generate different amounts of static electricity.
• Static electricity increases as humidity decreases.

Preventing Electrostatic Damage to Equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of sensitivity. The 
following packaging and grounding precautions are necessary to prevent damage to electric components and 
accessories.

• Transport products in static-safe containers, such as tubes, bags, or boxes to avoid hand contact.
• Protect all electrostatic parts and assemblies with conductive or approved containers or packaging.
• Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.
• Place items on a grounded surface before removing them from their container.
• When handling or touching a sensitive component or assembly, ground yourself by touching the chassis.
• Avoid contact with pins, leads, or circuitry.

Table 4-6 Static Electricity

Relative Humidity

Event 55% 40% 10%

Walking across carpet

Walking across vinyl floor
Motions of bench worker

7,500V
3,000V
400V

15,000V
5,000V
800V

35,000V
12,000V
6,000V

Removing bubble pack from PCB
Packing PCBs in foam-lined box

7,000V
5,000V

20,000V
11,000V

26,500V
21,000V

NOTE: 700V can degrade a product.
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• Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive foam.

Personal Grounding Methods and Equipment
Use the following equipment to prevent static electricity damage to equipment:

• Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground cords. To 
provide a proper ground, wear the strap against bare skin. The ground cord must be connected and fit snugly 
into the banana plug connector on the grounding mat or workstation.

• Heel straps, toe straps, and boot straps can be used at standing workstations and are compatible with most types 
of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with a maximum of one-
megohm ± 10% resistance between the operator and ground.

Grounding the Work Area
To prevent static damage at the work area:

• Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the work 
surface and properly grounded tools and equipment.

• Use static-dissipative mats, foot straps, or air ionizers to give added protection.
• Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate. Handle them only 

at static-free work areas.
• Turn off power and input signals before inserting and removing connectors or test equipment.
• Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
• Keep work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam.
• Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended Materials and Equipment
Materials and equipment that are recommended for use in preventing static electricity include:

• Antistatic tape
• Antistatic smocks, aprons, or sleeve protectors
• Conductive bins and other assembly or soldering aids
• Conductive foam
• Conductive tabletop workstations with ground cord of one-megohm ± 10% resistance
• Static-dissipative table or floor mats with hard tie to ground
• Field service kits
• Static awareness labels
• Wrist straps and footwear straps providing one-megohm ± 10% resistance
• Material handling packages
• Conductive plastic bags
• Conductive plastic tubes
• Conductive tote boxes
• Opaque shielding bags
• Transparent metallized shielding bags
• Transparent shielding tubes

4.1.3 Tools and Software Requirements
• Torx T-15 driver or flat-bladed screwdriver
• Phillips screwdriver
• Diagnostics software

Table 4-7 Static Shielding Protection Levels

Method Voltage

Antistatic plastic
Carbon-loaded plastic
Metallized laminate

1,500
7,500
15,000
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• Tamper-resistant T-15 wrench (Failsafe key) or tamper-resistant bits (required if you get locked out by solenoid 
hood lock)

Screws
The screws used in the workstation are not interchangeable. They might have standard or metric threads and might be 
of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP strongly 
recommends that all screws removed during disassembly be kept with the removed part, then returned to their proper 
locations.

NOTE: Metric screws have a black finish. American National (unified) screws have a silver finish.

NOTE: As each subassembly is removed from the workstation, place the subassembly away from the work area to 
prevent damage.

If necessary, additional drive guide screws are provided on the system chassis. There are eight Metric screws located 
on the chassis near the 5.25-inch optical drive bays. These screws can be used to mount additional optical drives or an 
optional diskette drive. There are four American National screws located on the chassis near the hard drive. These 
screws can be used to mount additional hard drives in the 3.5” hard drive cage. For more information about this 
procedure, see “Installing Hard Drives in the Optical Drive Bay (Optional)” on page 87.

NOTE: The Metric (black) and American National (silver) screws are not interchangeable.

4.1.4 Special Handling of Components
The following components require special handling when servicing the workstation.

WARNING! Do not use the front bezel as a handle or lifting point when lifting or moving the workstation. Lifting the 
workstation from the front bezel or lifting it incorrectly could cause the unit to fall and cause harm to the user and 
damage to the workstation. To properly and safely lift the workstation, lift it from the bottom of the unit from either the 
desktop or minitower configuration.

Cables and Connectors
Cables must be handled with care to avoid damage. Apply only the tension required to seat or unseat the cables during 
insertion or removal from the connector. Handle cables by the connector or pull strap whenever possible. In all cases, 
avoid bending or twisting the cables, and be sure that the cables are routed in such a way that they cannot be caught 
or snagged by parts being removed or replaced.

1 Metric screws (8)

2 American National screws (4)
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CAUTION: When servicing this workstation, be sure that cables are placed in their proper location during the 
reassembly process. Improper cable placement can damage the workstation.

Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies to failed 
drives as well as replacement spares.

• If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging and 
label the package “Fragile: Handle With Care.”

• Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective packaging 
until they are actually mounted in the workstation.

• Avoid dropping drives from any height onto any surface.
• If you are inserting or removing a hard drive, turn off the workstation. Do not remove a hard drive while the 

workstation is on or in Standby mode.
• Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid 

touching the connector. For more information about preventing electrostatic damage, refer to “Electrostatic 
Discharge Information” on page 50.

• Do not use excessive force when inserting a drive.
• Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields such as 

monitors or speakers.

Lithium Coin Cell Battery
The battery that comes with the workstation provides power to the real-time clock and has a minimum lifetime of about 
three years.

For instructions on battery removal and replacement, see the “Battery” on page 76.

WARNING! This workstation contains a lithium battery. There is a risk of fire and chemical burn if the battery is 
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or expose it 
to temperatures higher than 140 F (60 C).

CAUTION: Batteries, battery packs, and accumulators should not be disposed of together with the general household 
waste.Batterij niet

weggooien,
maar inleveren

als KCA.
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4.2 Pre-Disassembly Procedures
Before servicing the workstation:

1. Close any open software applications.
2. Remove any diskette or compact disc from the workstation.
3. Exit the operating system.
4. Turn off the workstation and any peripheral devices that are connected to it.
5. Remove/disengage any security devices that prohibit opening the workstation.

CAUTION: Turn off the workstation before disconnecting any cables.

CAUTION: The cooling fan is off only when the workstation is turned off or the power cable has been disconnected. 
The cooling fan is always on when the workstation is in the “On,” “Standby,” or “Suspend” modes. You must 
disconnect the power cord from the power source before opening the workstation to prevent system board or 
component damage.

6. Disconnect the power cord from the electrical outlet and then from the workstation.
7. Disconnect all peripheral device cables from the workstation.
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4.3 System Board 
This section provides additional information about the system board.

• Section 4.3.1 “System Board Components”
• Section 4.3.2 “System Board Architecture”

4.3.1 System Board Components
The following illustration shows the system board connectors and sockets on the HP xw4300 Workstation.

Table 4-8 System Board Components

1 Second serial port adapter 13 Serial ATA ports 25 PCI

2 Rear fan 14 Clear CMOS button 26 PCI Express x1

3 Processor power connector 15 Front chassis fan 27 PCI Express x8’ (x4)

4 Processor 16 Front control panel 28 PCI

5 Solenoid hood lock 17 Password jumper 29 PCI Express x16

6 Processor fan connector 18 Battery 30 Network/USB

7 Memory module sockets 19 Front USB 31 Audio

8 Main power 20 Hard disk activity LED 32 USB

9 Diskette drive connector 21 Chassis speaker 33 Parallel

10 Primary IDE* connector 22 Front audio 34 Serial

11 Chassis intrusion switch 23 Auxiliary audio 35 Keyboard/mouse

12 Boot block jumper 24 CD-ROM audio

*The Primary IDE connector is only used for optical drives.
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4.3.2 System Board Architecture
The following illustration shows the HP xw4300 Workstation block diagram.
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4.4 Steps for Removal and Replacement of Components
This section discusses the procedures necessary to remove and install various hardware components on your workstation. 
Review the safety and precautions and “Service Considerations” on page 50, as well as the Safety and Regulatory 
Guide, before servicing or upgrading your system.

1. Read all safety information and precautions.
2. Locate and clear a suitable work area.
3. Shut down the system and remove power from the unit.
4. Gather your tools.
5. Service your unit.
6. Restore power to your unit.

4.5 Disassembly Order
Use the following table to determine the sequence in which to remove the major components.

Pre-Disassembly (section 4.2)

Locks (section 4.6)

Access Panel (section 4.9)

Hood Sensor (section 4.10)

Front Bezel (section 4.12)

Front Panel I/O Assembly (section 
4.14)

Power Button (section 4.15)

Optical Drive (section 4.24)

Diskette Drive (section 4.26)

Bezel Blanks (section 4.13)

System Speaker (section 4.16)

Power Supply (section 4.17)

System Fan (section 4.18)

Memory (section 4.19)

Battery (section 4.22)

Hard Drive (section 4.27)

Processor Heatsink (section 4.29)

Processor (section 4.30)

PCI or PCI Express Cards (section 4.20)

System Board (section 4.31)
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4.6 Security Lock (Optional)
If a security lock is installed, remove it before servicing the unit. To remove the security lock, unlock it and slide it out of 
the padlock loop as shown in the following illustration.

4.7 Cable Lock (Optional)
If a cable lock is installed, remove it before servicing the unit. To remove the cable lock, unlock it and pull it out of the 
cable lock slot as shown in the following illustration.
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4.8 Universal Chassis Clamp Lock (Optional)
If a universal chassis clamp lock is installed, remove it before servicing the unit. 

To remove the lock:

1. Unlock the device and remove the locking mechanism.

2. Remove the screw attaching the lock to the chassis.
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4.9 Access Panel
Before accessing the internal components of the workstation, the access panel must be removed. 

To open the access panel:

WARNING! Before removing the workstation access panel, be sure that the workstation is turned off and that the 
power cord is disconnected from the electrical outlet.

1. Disconnect power from the system (section 4.2) and lay the workstation on its side as shown.
2. Pull up on the latch 1, slide the access panel 2 toward the rear of the workstation and then lift the access panel 

off.

To replace the access panel, lay it flat on the unit about one inch from the bezel. The hooks should fall into the recesses. 
Then, slide the cover toward the bezel until it snaps into place.

4.10 Hood Sensor
To remove the hood sensor: 

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the hood sensor connector 1 from the system board.
3. Slide the hood sensor forward, push it down, and remove it 2 from the chassis.

CAUTION: Be careful when sliding the hood sensor forward. The hood sensor bracket and the chassis contain sharp 
edges that present a safety hazard.

To replace the hood sensor, reverse the previous steps.
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4.11 Solenoid Hood (Smart Cover) Lock (Optional)
To remove the solenoid lock:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the solenoid hood lock cable 1 from the system board.
3. Using the FailSafe key (T-15 wrench), unscrew the two screws 2 from the back of the chassis as shown in the 

following diagram.
To purchase a FailSafe key, contact your authorized HP reseller or service provider or visit the HP Web site 
(http://www.hp.com) for ordering information.

4. Slide the solenoid hood lock assembly 3 away from the chassis and out of the unit.

To replace the solenoid hood lock assembly, reverse the previous steps.

4.12 Front Bezel
To remove the front bezel:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Lift up on the two tabs 1 located on the front bezel.
3. Rotate the front bezel away 2 from the chassis and remove the bezel.

To replace the front bezel, reverse the previous steps. 
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4.13 Bezel Blanks
To remove the bezel blank:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the front bezel 
(section 4.12).

2. Gently push the subpanel 1 out the back of the front bezel.
3. Remove the desired bezel blank by applying outward pressure on the subpanel 1 and pulling the blank 2 away.

NOTE: The bezel blanks are keyed to assist you in replacing the blanks. Also, the subpanel can be rotated 90 degrees 
to install the optical drives in desktop orientation, if desired.
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4.14 Front Panel I/O Device Assembly
To remove the front panel I/O device assembly:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the front bezel 
(section 4.12).

2. Unlatch the plastic snap that secures the cables inside the chassis and disconnect the front panel I/O device 
assembly cables from the system board.

3. Remove the two smaller Torx screws 1 that hold the front panel I/O device assembly 3 and bracket to the 
chassis.

4. Remove the two larger Torx screws 2 that hold the front panel I/O device assembly 3 to the bracket.
5. Separate the bracket away from the front panel I/O device assembly.

WARNING! The next step requires the removal of cables through the chassis. Some edges on the chassis might be 
sharp. Be careful when removing these cables.

6. Pull the front panel I/O device assembly out about two inches away 4 from the chassis.
7. Pull the front panel cables through the chassis and out the front of the unit. You might have to slide the cables out 

one at a time. 
 

To replace the front panel I/O device assembly:

WARNING! The next step requires threading cables through the chassis. Some edges on the chassis might be sharp. 
Be careful when installing these cables.

1. Thread each front panel I/O device assembly cable through the same holes from which they were removed.
2. Push the front panel I/O device assembly in to the chassis. Using your fingers, orient the cables so that there is 

enough room for the front panel I/O device assembly to easily fit in its slot. 
3. Loosely put the bracket on the front panel I/O device assembly and hook the bracket to the chassis.
4. Screw the bracket to the front panel I/O device assembly and screw the bracket to the chassis. 
5. Connect the front audio cable to 1. Connect the front USB cable to 2. Connect the front control panel cable 

to 3. If an IEEE-1394 card is installed, connect the front IEEE-1394 cable to the card. 
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4.15 Power Button
To remove the power button:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), remove the front bezel 
(section 4.12), and remove the front panel I/O device assembly (section 4.14).

2. Disconnect the power button cable from the system board.
3. Press in on the clips that secure the power button to the chassis.
4. Dislodge the metal clip from the chassis by rocking the power button back and forth. Then slide the power button 

assembly 2 out from the front of the chassis.

4.16 System Speaker
To remove the speaker:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the speaker cable 1 from the system board.
3. Remove the four screws 2 securing the speaker to the chassis and lift the speaker out of the chassis.
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4.17 Power Supply
To remove the power supply:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).

TIP: This next step requires disconnecting several power cables. To speed up reinstalling the power supply, it is helpful 
to write down the numbers on the cables so that you can easily reconnect the cable to the correct devices.

2. Disconnect all cables from the system board, drives, or cards. 
3. Remove the four screws 1 from the back panel.
4. Slide the power supply toward the front and lift it 2 out of the chassis.

To replace the power supply, reverse the previous steps. 
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4.18 System Fan
To remove the system fan:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the fan plug 1 from the system board.
3. Remove the four screws 2 from the rear of the chassis with a Phillips screwdriver.

To replace the system fan, reverse the previous steps.

CAUTION: When replacing the system fan, be sure that the fan is situated so that the airflow direction arrow is 
pointing toward the rear of the chassis. 
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4.19 Memory
To remove a memory module:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).

CAUTION: To ensure that memory modules are not damaged during removal or installation, power off the workstation 
and unplug the power cord from the AC power outlet. Wait until the LED on the back of the power supply turns off 
before removing memory. If you do not unplug the power cord while installing memory, your memory modules might 
be damaged and the system will not recognize the memory changes.

2. Gently push outwards on the socket levers 1.
3. Lift the DIMM 2 straight up and remove it from the unit. Store the DIMM in an anti-static bag.

4.19.1 Memory Module Features 
• Contains four memory slots for DIMMS
• Supports 256MB–4GB configurations
• Supports dual-channel DIMMs

4.19.2 Memory Module Requirements

CAUTION: HP only ships DIMMs that are electrically and thermally compatible with this product. Because third-party 
DIMMs might not be electrically or thermally compatible, they are not supported by HP.

NOTE: DIMMs and their sockets are keyed for proper installation. Be sure these guides line up when installing DIMMs.

• Use only industry-standard, unbuffered, PC2-4200 (533MHz) or PC2-5300 (667MHz) DIMMs
• Match DIMM pairs by size and type
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4.19.3 Required Loading Order
Use the following illustration as a guide for installing memory:

• If installing only one DIMM, install it in socket 1.
• Install the first DIMM pair in sockets 1 and 3. 
• Install the second DIMM pair in sockets 2 and 4. 

To install a memory module: 

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Gently push outwards on the socket levers.
3. Lower the DIMM straight down 1 and secure the socket levers 2 into place.
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4.20 Peripheral Component Interconnect (PCI) Slots
The section contains information on the following topics:

• “PCI Slot Types” on page 69
• “PCI Card Support” on page 70
• “PCI Express” on page 71
• “PCI” on page 73

4.20.1 PCI Slot Types
Your workstation contains three PCI slots, one PCI Express x1 slots, one PCI Express x8’ (x4), and a single PCI Express 
x16 slot (usually used for high-end graphics). The following table describes the slots, card types, and maximum slot 
power.

NOTE: Adjacent cards can have electromagnetic interactions with each other. As a practical matter, it is a good 
practice to physically separate high-speed cards from slower cards that may unintentionally couple some of their 
electromagnetic energy outside the box. Specifically, NIC cards should be located at least two slots away from 
graphics or SCSI controller cards, if possible, to minimize electromagnetic emissions. 

Table 4-9 PCI and PCI Express Slot Power Specifications

Slot# Slot Type Slot Power (Maximum)

1 PCI Express x16 graphics 75W*

2 PCI 25W*

3 PCI Express x8’ (x4) 25W*

4 PCI Express x1 25W*

5 PCI 25W*

6 PCI 25W*

* In addition to these slot power specifications, the overall power consumption of the system (including I/O cards, processor, and 
memory) must not exceed the maximum ratings of the system power supply.
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4.20.2 PCI Card Support
For added protection, some cards have PCI holders installed to prevent movement during shipping.

To remove the card support:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Remove the two screws 1 retaining the card support and lift 2 it out of the chassis.

To install card support: 

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Engage the rear bracket 1 with the holes in the rear of the chassis before rotating it down 2 into position.
3. Secure the bracket with two screws 3. 
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4.20.3 PCI Express
PCI Express, a hardware interconnect standard (for example, I/O slots), is a point-to-point architecture and uses a serial 
data transmission protocol. A single PCI Express lane consists of four wires and is capable of transmitting 250MB in a 
single direction or 500MB in both directions simultaneously. This bandwidth is not affected by what is happening on 
other PCI Express buses or legacy PCI/PCI-X buses (provided that total bandwidth can be handled by the CPU and the 
memory subsystem). The transmission protocol is similar to what is used for a LAN connection and contains error 
correction and detection, packet addressing, and other network features. 

PCI Express improves system attributes. PCI Express enables a low-power, scalable, high-bandwidth communication path 
with a small number of connections (wires) compared to traditional parallel interfaces (for example, PCI).

The PCI Express I/O slots can support other PCI Express cards with lesser bus bandwidth than what is physically defined 
for the slot. Use the following table to determine compatibility.

Table 4-10 PCI Express Compatibility Matrix for HP xw4300 Workstation

Mechanical Compatibility Electrical Compatibility

PCI Express x1 Slot x1 cards x1 modes

PCI Express x8’ (x4) Slot x1, x4, and x8 cards x1 and x4 modes

PCI Express x16 Slot x1, x4, x8, and x16 cards x1 and x16 modes
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To remove a PCI Express card: 

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9) and remove the PCI card 
support (section 4.20.2), if installed.

2. Lift the PCI levers 1 by first pressing down and then up.
3. If removing a PCI Express x16 graphics card, press in on the “hockey stick” lever 2 while lifting the card 3 out 

of the chassis. Store the card in an anti-static bag.
If removing another type of PCI Express card, lift the card out of the chassis. You do not need to press in on the 
“hockey stick” lever. 

4. Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards are properly 
seated and then try again.

To install a PCI Express card:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9) and remove the PCI card 
support (section 4.20.2), if installed.

2. Lift the PCI levers 1 by first pressing down and then up.

3. Remove the PCI slot cover 2.

4. Lower the PCI Express 3 card into the chassis. Verify that the keyed components of the card align with the socket. 

5. Close the PCI levers 4. If the PCI levers do not close, be sure all cards are properly seated.
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4.20.4 PCI 
To remove a PCI card: 

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9) and remove the PCI card 
support (section 4.20.2), if installed.

2. Lift the PCI levers 1 by first pressing down and then up.
3. Lift the PCI card 2 out of the chassis. Store the card in an anti-static bag.
4. Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards are properly 

seated and then try again.

To install a PCI card:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9) and remove the PCI card 
support (section 4.20.2), if installed.

2. Lift the PCI levers 1 by first pressing down and then up.
3. Remove the PCI slot cover 2.
4. Lower the PCI 3 card into the chassis. Verify that the keyed components of the card align with the socket. 
5. Close the PCI levers 4. If the PCI levers do not close, be sure all cards are properly seated and then try again.
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4.20.5 IEEE-1394 (Optional)
To remove an IEEE-1394 card: 

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9) and remove the PCI card 
support (section 4.20.2), if installed.

2. Lift the PCI levers 1 by first pressing down and then up.
3. Disconnect the front I/O cable and power cable 2 from the card.
4. Lift the IEEE card 3 out of the chassis. Store the card in an anti-static bag.
5. Install a PCI slot cover and close the PCI levers. If the PCI levers do not close, be sure all cards are properly 

seated and then try again.

To install an IEEE-1394 card, reverse the previous steps.
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4.21 Front Fan (Optional)
To remove the front fan:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the header 1 from the system board and thread it out of the card guide. Note that the system board 

connector refers to “PCI fan.”
3. Unsnap the fan housing from the chassis 2 and lift it 3 out of the workstation.

4. Remove the fan from the fan housing by applying outward pressure on the fan housing while pushing the fan out 
of the housing.

To replace the front fan, reverse the previous steps, but be sure that the airflow direction arrow on the side of the fan 
points to the rear of the chassis.
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4.22 Battery

CAUTION: Before removing the battery, be sure your Complementary Metal Oxide Semiconductor (CMOS) settings 
are backed up because all CMOS settings are lost when the battery is removed. To back up the CMOS settings, use 
Computer Setup and run the Save to Diskette option from the File menu.

To remove the battery:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. On the system board, press on the release tab of the battery holder 1.
3. Lift the battery straight up 2.

To replace the battery, slide the battery back in until it snaps back into place.
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4.23 Power Connections 
For help in identifying power cables, refer to the following information. Route or tie cables so that there is no possible 
way for them to interfere with the CPU heatsink fan. 

Table 4-11 Power Connections

P1 Main power on system board

P2 N/A

P3 CPU power

P4 PCI Express graphics auxiliary

P5 PCI (e.g. 1394) auxiliary

P6 ODD IDE top bay

P7 ODD IDE mid bay

P8 FDD

P9 3rd HDD SATA bottom ODD bay

P10 4th HDD SATA mid ODD bay

P11 ODD IDE or 3rd HDD SCSI ODD bottom bay

P12 1st HDD SATA bottom HDD bay

P13 2nd HDD SATA top HDD bay

P14 1st HDD SCSI bottom HDD bay

P15 2nd HDD SCSI top HDD bay
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4.24 Optical Drive (Minitower Position)
To remove an optical drive:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the front bezel 
(section 4.12).

2. Disconnect the power 1, data 2, and audio 3 cables from the drive. The connector colors might be different 
than illustrated.

NOTE: The audio cable is only required for Linux-based systems. 

3. Lift the green drivelock release lever 1 and gently slide the drive 2 out of the chassis.
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4. After pulling the drive 1 out, remove the four guide screws 2 from the drive. Only remove the four guide screws 
if you plan to install another drive.

To install an optical drive: 

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), remove the front bezel 
(section 4.12), and remove a bezel blank (section 4.13), if necessary.

2. Insert the four guide screws 1 into the drive. 
3. Align the screws with the grooves in the drive bay and gently slide 2 the drive into the unit until it snaps into 

place.

CAUTION: Ensure that the optical drive is secure by pulling to see if the drive can become easily disengaged. Failure 
to do so can cause damage to the drive when moving the workstation.

4. Connect the power, drive, and audio (if required) cables to the drive and system board. On Linux systems, 
connect the audio cable to the AUX-IN connector.

NOTE: The audio cable is only required for Linux-based systems. 
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4.25 Optical Drive (Desktop Position)
To remove an optical drive:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the front bezel 
(section 4.12).

2. Disconnect the audio 1, data 2, and power 3 cables from the drive. The connector colors might be different 
than illustrated.

NOTE: The audio cable is only required for Linux-based systems. 

3. Press down on the yellow drivelock release lever 1 and gently slide the drive 2 out of the chassis.

4. After pulling the drive 1 out, remove the four guide screws 2 from the drive as shown in the illustration below. 
Only remove the four guide screws if you plan to install another drive.

To install an optical drive: 

1. Remove the front bezel and bezel blanks.
2. Insert the four guide screws into the drive. 
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3. Align the screws with the slots on the drive and slide the drive into the unit until it snaps into place.

CAUTION: Ensure that the optical drive is secure by pulling to see if the drive can become easily disengaged. Failure 
to do so can cause damage to the drive when moving the workstation.

4. Connect the power, drive, and audio (if required) cables to the drive and system board. On Linux systems, 
connect the audio cable to the AUX-IN connector.

NOTE: The audio cable is only required for Linux-based systems. 
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4.26 Diskette Drive
To remove a diskette drive:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the front bezel 
(section 4.12).

2. Disconnect the data 1 and power 2 cables from the back of the diskette drive.

3. Lift the green drivelock release tab 1 and gently slide the drive 2 out at the same time. 

To replace a diskette drive:

1. Align the metal protrusions on the side of the drive with the grooves in the diskette drive bay and slide the diskette 
drive into the bay until it stops. 

2. Connect the data cable to the diskette drive 1 and to the system board 2. 

3. Connect the power cable to the diskette drive.
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4.27 SCSI Hard Disk Drive
To remove a hard drive:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the data 1 and power 2 cables from the hard drive.

3. Lift up on the green drivelock release tab 1 and slide the hard drive 2 out of the chassis.

To install a SCSI hard drive: 

For more information on SCSI hard drives, see “SCSI Devices” on page 127.

Before installing a SCSI hard drive on your system, you must give the hard drive a unique SCSI ID.

All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device that is installed. The reserved and available 
SCSI ID numbers are displayed in the following list:

• 0 is reserved for the primary hard drive (not reserved for the primary hard drive on Linux).
• 7 is reserved for the SCSI controller.
• 1 through 6 and 8 through 15 are available for all other SCSI devices.

When 0 is used for the primary hard drive, set the second hard drive to 1, the third to 2, and so on.

To set the SCSI ID on a drive, see the instructions on top/back of the hard drive for the correct jumper settings. The drive 
probably displays a diagram of the jumper block. This diagram shows you which blocks to cover with your jumper to 
get the desired ID.

For example, if the drive must be set to 3, the drive might show that the 4 ID bits are at the far left of the connector (ID0, 
ID1, ID2, and ID3), then using the jumpers provided, cover the pins to set the SCSI ID.

After you have given the hard drive a unique SCSI ID, you can install the hard drive into your system.

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
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2. Select a drive bay in which to install the drive. 
3. Push the drive 1 into the selected bay until it snaps into place.
4. Attach the data 2 and power 3 cables to the drive.

5. Insert the SCSI controller card into an available PCI slot (section 4.20.4).
6. Connect the data cable from the hard drive 1 to the controller card 2. 
7. Connect the hard drive LED cable from the card to the hard drive LED connector on the system board. You can 

find the location of this connector on the illustration on the inside of the access panel.
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4.28 SATA Hard Drive
For more information on SATA hard drives and the SATA RAID configuration, see “SATA Devices” on page 125.

To remove a SATA hard drive: 

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Disconnect the data 1 and power 2 cables from the hard drive.

3. Lift up on the green drivelock release tab 1 and slide the hard drive 2 out of the chassis.
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To install one to two SATA drives:

1. Disconnect power from the system (section 4.2) and open the access panel (section 4.9).
2. Select a drive bay in which to install the drive. 
3. Push the drive into the selected bay until it snaps into place.
4. Connect the data cable 1 and power cable 2 to the hard drive.

5. Connect the data cable 1 from the hard drive to the serial ATA port 2. SATA0 port is shown in the following 
illustration.
• Connect SATA 0 to SATA0 (P60).
• Connect SATA 1 to SATA1 (P61).

To install three to four SATA hard drives:

1. Follow the instructions for installing two SATA hard drives (page 86).
2. Follow the instructions for installing the hard drive into the optical drive slot (page 87).

NOTE: If installing three SATA hard drives, you must install hard drives in at least one optical drive bay. If installing four 
SATA hard drives, you must install hard drives in at least two optical drive bays. 

3. Attach the power and data cable to the drive.
• Connect SATA 2 to SATA2 (P62).
• Connect SATA 3 to SATA3 (P63). 
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4.28.1 Installing Hard Drives in the Optical Drive Bay (Optional)
1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the front bezel 

(section 4.12).
2. Place the hard drive in the bracket 1 and secure with American National screws 2 as shown in the following 

illustration.

3. Screw four screws to the bracket 1. Align the screws with the grooves in the optical drive bay and slide the drive 
in 2 the chassis.

4. Connect the data cable to the hard drive 1 and to the system board 2. SATA installation is shown.
5. Connect the power cables (not shown).
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4.29 CPU Heatsink

CAUTION: Different versions of the CPU heatsink exist, but the overall procedures listed are sufficient to assist you in 
removing the heatsink. 

To remove the CPU heatsink:

1. Turn on the workstation and enter Computer Setup (F10) (section 3.1). Let the workstation run in this mode for five 
minutes. 
This action warms the thermal interface material between the CPU heatsink and processor so that the thermal 
bond loosens and can more easily be broken. 

CAUTION: Removing the CPU heatsink while the thermal compound is cold puts unnecessary mechanical stress on the 
CPU and the CPU socket. This action could damage the processor and the processor socket. 

NOTE: Windows in idle state does not provide sufficient heat to warm the compound.

2. After warming the thermal interface, shut down the system, disconnect power from the system (section 4.2) and 
open the access panel (section 4.9).

3. Loosen the captured heatsink screws from the system board in pairs. Begin by slightly loosening any two screws 
that are diagonally opposite from one another, then slightly loosen the other two. Then finish removing the 
screws.

4. Gently twist the heatsink unit to break the thermal grease binding.
5. Disconnect the CPU heatsink cable 1 from the system board.
6. Lift the CPU heatsink 2 unit. 
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7. Use alcohol and a soft cloth to clean all the thermal interface material residue from the CPU heatsink and 
processor.

CAUTION: Allow the alcohol on the processor and CPU heatsink to dry completely.

8. Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU heatsink and 
processor.

To replace the CPU heatsink:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the CPU 
heatsink (section 4.29).

2. Use alcohol and a soft cloth to clean all of the thermal interface material residue from the CPU heatsink and 
processor.

CAUTION: Allow the alcohol on the processor and CPU heatsink to dry completely.

3. Check for proper processor seating in the socket by carefully trying to lift the processor out of the socket with your 
fingers. A properly seated processor does not lift out of the socket.

4. Apply thermal grease to center of the processor. If using a new CPU heatsink, remove and discard the thermal 
grease protective liner from the bottom of the new CPU heatsink.

NOTE: Do not touch the exposed thermal grease when handling the CPU heatsink.

5. Lower the CPU heatsink onto the system board.
6. Carefully tighten the four screws a little at a time; do not fully tighten one screw and move onto the next. Be sure 

the processor remains level and be sure you do not overtighten the screws. If you have a torque-limited driver 
available, tighten the screws to the correct torque setting of 6 in-lbs.

CAUTION: Do NOT overtighten the screws. If you overtighten the screws, you risk stripping the threads in the system 
board tray. 
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4.30 Processor
To remove the processor:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), and remove the CPU 
heatsink (section 4.29).

2. Raise the lever 1 on the processor socket handle and open the cover 2.
3. Pull the processor 3 straight out of the socket.

CAUTION: Avoid bending the protrusions in the CPU socket. This mishandling can damage the CPU socket. 

NOTE: Store the processor in a safe place where it will not be damaged. 

To replace the processor: 

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), remove the CPU heatsink 
(section 4.29), and remove the processor (section 4.30).

2. Raise the processor socket handle fully (the full swing angle of the lever is approximately 90 degrees).

CAUTION: Processor pins are delicate and bend easily. Use extreme care when placing the processor in the socket.

3. Line up the triangle on the top of the processor with the triangle on the corner of the processor socket and install 
the processor into the socket. Ensure that the underside of the processor is level with the top of the processor 
socket. Lightly press down on the top of the processor while closing the socket lever.

 

Removal and Replacement Procedures90



Re
m

ov
al

 a
nd

 R
ep

la
ce

m
en

t 
Pr

oc
ed

ur
es

 

4. Check for proper processor seating in the socket by carefully trying to lift the processor out of the socket with your 
fingers. A properly seated processor does not lift out of the socket.

5. Replace the CPU heatsink (section 4.29).
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4.31 System Board
To remove the system board:

1. Disconnect power from the system (section 4.2), open the access panel (section 4.9), remove all plug-in cards 
and graphics cards (section 4.19), and remove the system fan assembly (section 4.18).

2. Disconnect all cabling from the system board.

NOTE: Make note of the cable connections before disconnecting them from the system board. Refer to section 4.23 
“Power Connections” for more information.

3. Press the release tab as shown in the following illustration.
4. Slide the board toward the front of the chassis and then lift it out of the unit.

To replace the system board:

1. Lay the system board back in the chassis slightly away from the rear of the chassis. The mounting hooks should 
fall into the recesses of the tray so the tray lays flat on the chassis base.

NOTE: Be sure the system board connectors engage correctly with the rear I/O panel.

2. Slide the tray towards the rear of the chassis until the heat sink mounting holes line up.
3. Re-install the heatsink, cards, and cables
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5 System Diagnostics and Troubleshooting
This chapter discusses the tools available for diagnosing and troubleshooting system issues.

• Section 5.1 “Help & Support Center (HSC) and E-Support”
• Section 5.2 “Troubleshooting Checklist”
• Section 5.3 “LED Color Definitions”
• Section 5.4 “HP Insight Diagnostics Offline Edition”
• Section 5.5 “Troubleshooting Using HP Intelligent Manageability Features”
• Section 5.6 “Diagnostic Light Codes”
• Section 5.7 “Troubleshooting Scenarios and Solutions”
• Section 5.8 “Power On Self Test (POST) and Error Messages”
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5.1 Help & Support Center (HSC) and E-Support
HSC provides online access to technical support information, software updates and downloads, diagnostic tools, and 
HP support contact information.

To open HSC from your desktop, click Start > Help and Support.

HSC contains four sections:

• HP Product Information (requires Internet access)—Links to the HP Technical Support Web site for your product. 
You can access all related documentation, downloads and updates, tools, and more.

• HP Software & Driver Downloads (requires Internet access)—Links to HP specific software downloads and 
updates.

• HP Support Tools (requires Internet access)—Links to self-help tools and diagnostics offered by HP Instant Support 
Professional Edition.

• Contact HP for Support—Provides two different options:
• Chat with an expert online (requires Internet access)—Provides a tool to communicate with a support 

specialist online through Active Chat.
• Call a support agent—Provides hardware details about the workstation and HP support contact phone 

number worldwide.

5.2 Troubleshooting Checklist
Before running any of the diagnostic utilities, go through the following checklist to find possible solutions for workstation 
or software problems.

• Are the workstation and monitor connected to a working electrical outlet?
• Is the workstation turned on?
• Is the green power light illuminated?
• Is the monitor turned on?
• Is the green monitor light illuminated?
• Turn up the monitor brightness and contrast controls if the monitor is dim.
• Press and hold any key. If the system beeps, then the keyboard is operating correctly.
• Check all cables for loose or incorrect connections.
• Reconfigure the workstation after installing a non-PnP expansion board or other option, such as a diskette drive.
• Are all of the necessary device drivers installed?
• Have all printer drivers been installed for each application?
• Remove all diskettes and CDs from the drives before you turn on the system.
• Are you running the latest BIOS version, drivers, and software updates?

5.3 LED Color Definitions
An LED light exists on the front panel of your workstation. The following table describes what each color signifies. 

Table 5-I LED Color Definitions

LED State LED Color System Status

Solid Green System is on.

Blinking Green System is in Standby.

Solid or Blinking Red System has error. Refer to section 5.6.

None No light System is in Hibernate or it is off.
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5.4 HP Insight Diagnostics Offline Edition

NOTE: HP Insight Diagnostics is included on CD with some computer models only.

The HP Insight Diagnostics utility allows you to view information about the hardware configuration of the computer and 
perform hardware diagnostic tests on the subsystems of the computer. The utility simplifies the process of effectively 
identifying, diagnosing, and isolating hardware issues. 

The Survey tab is displayed when you invoke HP Insight Diagnostics. This tab shows the current configuration of the 
computer. From the Survey tab, there is access to several categories of information about the computer. Other tabs 
provide additional information, including diagnostic test options and test results. The information in each screen of the 
utility can be saved as an html file and stored on a diskette or USB HP Drive Key. 

Use HP Insight Diagnostics to determine if all the devices installed on the computer are recognized by the system and 
functioning properly. Running tests is optional but recommended after installing or connecting a new device. 

You should run tests, save the test results, and print them so that you have printed reports available before placing a call 
to the Customer Support Center. 

NOTE: Third party devices might not be detected by HP Insight Diagnostics.

5.4.1 Key Features and Benefits
HP Insight Diagnostics simplifies the process of effectively identifying, diagnosing, and isolating the hardware issues.

In addition to robust management tools, service tools can be invaluable in quickly resolving system problems. To 
streamline the service process and resolve problems quickly, it is necessary to have the right information available at 
the time that a service call is placed. Before calling, write down the configuration of the system. Insight Diagnostics helps 
provide higher system availability. Typical uses of the Insight Diagnostics are:

• Testing and diagnosing apparent hardware failures
• Documenting system configurations for upgrade planning, standardization, inventory tracking, disaster recovery, 

and maintenance
• Sending configuration information to another location for more in-depth analysis

5.4.2 Theory of Operation
Insight Diagnostics Offline Edition operates in offline mode only. The operating system is not running and software 
information from the system is not available to the diagnostics.

Offline Survey—displays the current system configuration.

Insight Diagnostics Test—provides the capability to test functionality of all the major hardware components in the 
system. The Test feature is designed to be flexible to enable the user to customize test selections by providing different 
modes and types of testing.

Quick Test—provides a predetermined script where a sample of each hardware component is exercised and requires 
no user intervention.

Complete Test—provides a predetermined script where each hardware component is fully tested. You can select 
Interactive or Unattended tests. This will change the devices tested during the Complete Test. There are more tests 
available in the interactive mode, but these require user intervention.

Custom Test—provides the most flexibility in controlling the testing of a system. The Custom Test mode enables the 
user to specifically select which devices, tests, and test parameters are run. Users are provided the ability to select tests 
that do not require any user interaction through the Interactive and Unattended tests modes.

5.4.3 Diagnostic Utility on CD
HP Insight Diagnostics is available on the Documentation and Diagnostics CD that was shipped with your HP 
Workstation.

To start the diagnostic utility on the Documentation and Diagnostics CD:

1. Insert the Documentation and Diagnostics CD into the workstation.
2. Restart your workstation and press the F9 key when the F10=Setup message appears on the screen.
3. After POST is completed, a list of bootable devices is displayed. Use the arrow keys to select the CD-ROM 

Drive and press Enter. The workstation then boots from the selected non-default device for this one time.
4. When the system boots, HP Insight Diagnostics launches automatically.
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5.4.4 Download the ISO Image
To download the latest diagnostic utility:

1. Visit http://www.hp.com/go/workstationsupport.
2. Select your HP Workstation.
3. Click the download driver and software link.
4. Select your OS.
5. Click the Diagnostic link.
6. Locate HP Insight Diagnostics and click Download.

NOTE: The downloaded file includes instructions on creating the bootable CD.

5.4.5 User Interface

Navigation
The Insight Diagnostics home page contains the following tabs: Survey, Test, Status, and Log. These tabs separate 
the major functions of Insight Diagnostics.

Survey Tab
When the Survey tab is selected, the Survey menu displays and enables you to view important system configuration 
information. The Summary view limits the amount of data displayed, while the Advanced view shows all the data 
in the selected category. Regardless of whether you choose Advanced or Summary, the following categories of 
information are available on the Survey menu:

• All—Gives a listing of all categories of information about the computer. 
• Overview—Gives you a listing of general information about the computer. 
• Architecture—Provides system BIOS and PCI device information. 
• Asset Control—Shows asset tag, system serial number, and processor information. 
• Communication—Shows information about the computer parallel (LPT) and serial (COM) port settings, plus 

USB and network controller information. 
• Graphics—Shows information about the graphics controller of the computer. 
• Input Devices—Shows information about the keyboard, mouse, and other input devices connected to the 

computer. 
• Memory—Shows information about all memory in the computer. This includes memory slots on the system 

board and any memory modules installed. 
• Miscellaneous—Shows information obtained from the computer configuration memory (CMOS), system 

management BIOS data, system board data, and diagnostics component information. 
• Storage—Shows information about storage media connected to the computer. This list includes all fixed disks, 

diskette drives, and optical drives. 
• System—Shows information about the system board, processor, chassis, and BIOS, plus internal speaker and 

PCI bus information.
• Multimedia—Shows information about the system Audio devices 

Test Tab
The Test tab allows you to choose various parts of the system to test. You can also choose the type of test and testing 
mode. 

There are two test modes to choose from: 

• Interactive Mode—Provides maximum control over the testing process. The diagnostic software will prompt you 
for input during tests that require your interaction.You may also determine whether the test passed or failed. 

• Unattended Mode—Does not display prompts and requires no interaction. If errors are found, they are displayed 
when testing is complete. 

The Insight Diagnostics utility provides the capability to test all the major pieces of hardware in the system. You can 
select from several types of tests: 

• Quick Test—Provides a predetermined script where a sample of each hardware component is exercised and 
requires no user intervention.

• Complete Test—Provides a predetermined script where each hardware component is fully tested. You can 
select Interactive or Unattended tests. This will change the devices tested during the Complete Test. There 
are more tests available in the interactive mode, but these require user intervention.
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• Custom Test—Provides the most flexibility in controlling the testing of a system. The Custom Test mode allows 
the user to specifically select which devices, tests, and test parameters are run. Users are provided the ability to 
select tests that do not require any user interaction through the Interactive and Unattended test modes.

To begin testing: 

1. Select the Test tab. 
2. On the left side of the tab, select the Type of Test to perform (Quick, Complete, or Custom). 
3. On the left side of the tab, select the Test Mode (Interactive or Unattended). 
4. Select the device to be tested from the drop-down list.
5. Choose how you want the test to be executed, either Number of Loops or Total Test Time. When choosing 

to run the test over a specified number of loops, enter the number of loops to perform. If you desire to have the 
diagnostic test for a specified time period, enter the amount of time in minutes. 

6. Click Begin Testing to start the test. The Status tab, which allows you to monitor the progress of the test, is 
automatically displayed during the testing process. When the test is complete, the Status tab shows whether the 
device passed or failed. 

7. If errors are found, go to the Log tab and click the Error Log to display more detailed information and 
recommended actions. 

Status Tab
The Status tab displays the status of the selected tests. The type of test executed (for example, Quick, Complete, 
Custom) is displayed. The main progress bar displays the percent complete of the current set of tests. While testing is 
in progress a Cancel Testing button, which will cancel the test job, is displayed.

After testing has completed, the Cancel Testing button is replaced with a Retest button. The Retest button will retest 
the last set of tests executed. This enables you to re-run the set of tests without having to go back to the test selection page. 

The Status page also shows:

• The devices being tested.
• The tests that are running.
• The overall elapsed time.
• The individual elapsed test times.
• The condition status of each test.

Log Tab
The Log tab contains two logs, a Test Log and an Error Log, each of which can be selected from the left side of the 
tab. 

The Test Log displays all tests that have been executed, the number of times of execution, the number of times the test 
failed, and the time it took to complete the test. The Clear Test Log button will clear the contents of the Test Log. 

The Error Log displays the tests for devices that have failed during the diagnostic testing and includes the following 
columns of information. 

• The Description section describes the error that the diagnostic test found. ]
• The Recommended Repair will give a recommended action that should be performed to resolve the failed 

hardware. 
• The Failed Count is the number of times the test has failed. 
• The Error Code provides a numerical code for the failure. 
• The Clear Error Log button will clear the contents of the Error Log. 

Saving and Printing Information in HP Insight Diagnostics 
You can save the information displayed in the HP Insight Diagnostics Status and Log tabs to a diskette or a USB 2.0 HP 
Drive Key (64MB or higher). You cannot save to the hard drive. The system will automatically create an html file that has 
the same appearance as the information displayed on the screen. 

1. Insert a diskette or USB 2.0 HP Drive Key (capacity must be 64MB or higher). USB 1.0 Drive Keys are not 
supported. 

2. Click Save in the upper-right corner of the tab. 
3. Select Save to the floppy or Save to USB key. 
4. Enter a file name in the File Name box and click the Save button. An html file will be saved to the inserted 

diskette or USB HP Drive Key. 
5. Print the information from the storage device used to save it. 
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NOTE: To exit HP Insight Diagnostics, click Exit in the upper-right corner of the screen then remove the Documentation 
and Diagnostics CD from the optical drive. 
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5.5 Troubleshooting Using HP Intelligent Manageability Features
The Local Alert Pop-Up Dialog notifies you of an impending or actual hardware failure. If the workstation is connect to 
a network and the HP Insight Management Agents are installed and configured, a Simple Network Management 
Protocol (SNMP) trap (message) is sent to the specified SNMP-compliant management application.

5.6 Diagnostic Light Codes
This sections provides an overview of the diagnostic lights that are related to your workstation.

NOTE: The beeps are heard through the on-board piezo speaker and not the chassis speaker. The blinking lights and 
beeps repeat for five cycles. After that, only the blinking lights repeat.

Table 5-2 Diagnostic Light Codes

Chassis Indicator Lights

Power LED and Sound Activity Diagnosis and Service Action

None System does not power on.
Press the power button. If the HDD LED is green:
1. Check that the power supply cables are properly connected to the system board.
2. Remove the expansion cards one at a time.
3. Replace the system board.
Or
Press the power button. If the HDD LED does not illuminate:
1. Check that the unit is plugged into a working AC outlet.
2. Check that the power button harness is properly connected to the in-line front panel I/O 

device assembly connector.
3. Check that the power supply cables are properly connected to the system board.
4. Check the power supply functionality.
a. Disconnect the AC power.
b. Remove all internal power supply cables from the system board.
c. Plug in the AC power.

• If the power supply fan spins and the BIST LED lights, the power supply is functional. 
Replace the system board.

• If the power supply fan does not spin or the BIST LED does not light, replace the power 
supply.

Beeps and blinks RED two times Thermal shutdown:
1. Ensure the workstation air vents are not blocked and the cooling fans are running.
2. Press the power button, and see if the fans on the CPU heatsinks spin. If they are not 

spinning, ensure the fan cable is plugged into the system board. Ensure the CPU heatsinks 
are properly seated.

3. If the CPU heatsinks are plugged in and seated but are not spinning, replace the CPU 
heatsinks.

4. Reseat the CPU heatsinks and verify the fan assemblies are properly attached.

Beeps and blinks RED 3 times CPU is not installed:
1. Install CPU.
2. Reseat CPU.

Beeps and blinks RED 4 times Power supply failure:
1. Locate the faulty device by removing all devices and then reinstalling one at a time until 

workstation fails. Replace the device causing the failure. Continue adding devices to ensure 
all are functioning properly.

2. Check the power supply functionality.
a. Disconnect AC power.
d. Remove all internal power supply cables from the system board.
e. Plug in AC power.

• If the power supply fan spins and the BIST LED lights, then the power supply is 
functional. Replace the system board.

• If the power supply fan does not spin or the BIST LED does not light, replace the power 
supply.
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Beeps and blinks RED 5 times Pre-video memory error:
1. Reseat memory modules.
2. Replace memory modules one at a time to find the faulty module.
3. Replace third-party modules with HP memory.
4. Replace system board.

Beeps and blinks RED 6 times Pre-video graphics card error:
For systems with integrated graphics, replace the system board.
For systems with graphic cards: 
1. Reseat the graphics card. 
2. Replace the graphics card.
3. Replace the system board. 

Beeps and blinks RED 7 times System board failure (ROM detected failure before video).
Replace system board.

Beeps and blinks RED 8 times Invalid ROM based on bad checksum.
1. Reflash the ROM.
2. Replace the system board.

Beeps and blinks RED 9 times System powers on but is unable to boot.
1. Replace the system board.
2. Replace the processor.

Table 5-2 Diagnostic Light Codes (continued)

Chassis Indicator Lights (continued)

Power LED and Sound Activity Diagnosis and Service Action
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5.7 Troubleshooting Scenarios and Solutions
This section presents an extensive overview of various troubleshooting scenarios and includes possible solutions for each.

5.7.1 Solving Minor Problems

Table 5-3 Solving Minor Problems

Problem Cause Possible Solution

Workstation appears locked up 
and does not turn off when the 
power button is pressed.

Software control of the power 
switch is not functional.

1. Press and hold the power button for at least four seconds 
until the workstation turns off.

2. Disconnect the electrical plug from outlet.

Workstation will not respond to 
USB keyboard or mouse.

Workstation is in Standby mode. Press the power button to resume from Standby mode.

CAUTION: When attempting to resume from Standby mode, do not hold down the power button for more than four 
seconds. Otherwise, the workstation will shut down and you will lose your data.

Workstation seems to be locked 
up.

Program in use has stopped 
responding to commands.

1. Attempt the normal shutdown procedure. 
2. Press the power button for four or more seconds to turn 

off the power. 
3. Restart the workstation using the power button.

Workstation does not retain 
date and time when powered 
off.

Real-time clock (RTC) battery might 
need to be replaced. 

1. For Windows, open the control panel and reset the date 
and time. 

2. Replace the RTC battery.

Workstation appears to pause 
periodically.

Network driver is loaded and no 
network connection is established.

Establish a network connection, or use Computer Setup or 
Microsoft Windows Device Manager to disable the network 
controller.

Cursor does not move using the 
arrow keys on the keypad.

The Num Lock key might be on. Press the Num Lock key. The Num Lock key can be 
disabled (or enabled) in Computer Setup.

Poor performance is 
experienced.

Processor is hot. 1. Be sure airflow to the workstation is not blocked.
2. Be sure the fans are connected and working properly 

(some fans only operate when needed).
3. Be sure the CPU heatsink is installed properly.

There is not enough memory. Add more memory.

Hard drive is full. Transfer data from the hard drive to create more space on 
the hard drive.

Workstation powered off 
automatically and beeps and 
blink RED twice.

Processor thermal protection 
activated:
A fan might be blocked or not 
turning.
OR 
The CPU heatsink is not properly 
attached to the processor.

1. Be sure workstation air vents are not blocked and the 
cooling fan is running.

2. Open hood, press power button, and see if the processor 
fan spins. If not spinning, be sure the fan’s cable is 
plugged onto the system board header. Be sure the fan is 
fully/properly seated or installed.

3. Replace the processor fan.
4. Reseat CPU heatsink and verify that the fan assembly is 

properly attached.
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System does not power on and 
the LEDs on the front of the 
workstation are not flashing.

System is unable to power on. Press and hold the power button for less than four seconds. If 
the hard drive LED turns green:
1. Check that the power supply cables are properly 

connected to the system board.
2. Remove the expansion cards.
3. Replace the system board.
OR
Press and hold the power button for less than four seconds. If 
the hard drive LED does not illuminate:
1. Check that the unit is plugged into a working AC outlet.
2. Open the access panel and check that the power button 

harness is properly connected to the in-line front panel I/
O device assembly connector.

3. Check that the power supply cables are properly 
connected to the system board.

4. Check the power supply functionality.
a. Disconnect the AC power.
f. Remove all internal power supply cables from the system 

board.
g. Plug in the AC power.

• If the power supply fan spins and the BIST LED lights, 
the power supply is functional, so replace the system 
board.

• If the power supply fan does not spin or the BIST LED 
does not light, replace the power supply.

Table 5-3 Solving Minor Problems

Problem Cause Possible Solution
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5.7.2 Solving Power Supply Problems

Testing Power Supply
Before replacing the power supply, use the Built-In Self-Test (BIST) feature to learn if the power supply still works.

To test the power supply:

1. Disconnect all internal power supply cables.
2. Plug in the AC power.

• If the green BIST LED on the rear of the workstation is lit AND the fan is spinning, the power supply is 
functional.

• If the green BIST LED is not lit OR the fan is not spinning, replace the power supply.

Table 5-4 Power Supply Problems

Problem Cause Solution

Power supply shuts down 
intermittently.

Power supply fault. Replace the power supply.

Workstation powered off 
automatically and beeps and blinks 
RED two times

Processor thermal protection 
activated:
A fan might be blocked or not 
turning.
OR 
The CPU heatsink assembly is 
not properly attached to the 
processor.

1. Be sure that the workstation air vents are not blocked 
and the cooling fan is running.

2. Open the access panel, press the power button, and 
see if the fan on the heatsink spins. If the fan is not 
spinning, be sure the heatsink cable is plugged into the 
system board header. Be sure the fan is properly 
seated or installed.

3. Replace the CPU heatsink.
4. Reseat the CPU heatsink and verify that the fan 

assembly is properly attached.
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5.7.3 Solving Diskette Problems

Table 5-5 Diskette Problems

Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Windows, open Explorer and select File > 
Properties > Tools. Under Error-checking, click 
Check Now.

Diskette is incorrectly inserted. Remove diskette and reinsert.

Files on diskette are damaged. Reload files on new diskette.

Drive cable is not properly 
connected.

Reconnect power cable. Be sure that all four pins are 
connected.

Drive not found. Cable is loose. Reseat diskette drive data and power cables.

Removable drive is not seated 
properly.

Reseat the drive.

Diskette drive cannot write to a 
diskette.

Diskette is not formatted. Format the diskette.

Diskette is write-protected. Use another diskette or remove the write protection.

Writing to the wrong drive. Check the drive letter in the path statement.

Not enough space is left on the 
diskette.

Use another diskette.

Diskette write control is enabled. Use Computer Setup to check the storage security feature 
disabled settings.

Diskette is damaged. Replace the damaged disk.
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Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, you might need to 
specify diskette capacity. For example, to format a 1.44-
MB diskette, enter the following command at the MS-
DOS prompt:
FORMAT A: /F:1440

A problem has occurred with a disk 
transaction.

The directory structure is bad, or 
there is a problem with a file.

In Windows, right-click Start > Explore, and select a 
drive. Select File > Properties > Tools. Under Error-
checking, click Check Now.

Diskette drive cannot read a diskette. Diskette is not formatted. Format the diskette.

You are using the wrong diskette 
type for the drive type.

Check the type of drive that you are using and use the 
correct diskette type.

You are reading the wrong drive. Check the drive letter in the path statement.

Diskette is damaged. Replace the diskette with a new one.

“Invalid system disk” message is 
displayed.

A diskette that does not contain 
the system files needed to start 
the workstation has been inserted 
in the drive.

When drive activity stops, remove the diskette and press 
the Spacebar. The workstation should start up.

Diskette error has occurred. Restart the workstation by pressing the power button.

Cannot Boot from Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been disabled 
in Computer Setup.

Run Computer Setup and enable diskette boot in 
Storage > Boot Order.

Removable media boot has been 
disabled in Computer Setup.

Run Computer Setup and enable Removable Media Boot 
in Storage > Storage Options.

Table 5-5 Diskette Problems (continued)

Problem Cause Solution
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5.7.4 Solving Hard Drive Problems

Table 5-6 Hard Drive Problems

Problem Cause Solution

Hard drive error occurs. Hard disk has bad sectors or 
has failed.

Use a utility to locate and block usage of bad sectors. If 
necessary, reformat the hard disk.

Disk transaction problem. Either the directory structure is 
bad or there is a problem with a 
file.

In Windows, open Explorer, select a drive, and select File 
> Properties > Tools. Under Error-checking, click 
Check Now.

Drive not found (identified). Loose cable. Check cable connections.

The system might not have 
automatically recognized a 
newly installed device.

1. Run Computer Setup.
2. If the system still does not recognize the new device, 

check to see if the device is listed within Computer 
Setup. If it is listed, the probable cause is a driver 
problem. If it is not listed, the probable cause is a 
hardware problem.

3. If this is a newly installed drive, enter Setup and try 
adding a POST delay under Advanced > Power-
On.

Drive’s SATA controller is 
disabled in Computer Setup.

Run Computer Setup and enable the SATA controllers in 
Storage>Storage Options. 

Drive’s SCSI controller is 
disabled in Computer Setup.

Run Computer Setup and enable the SCSI controllers in 
Storage>Storage Options. 

Drive responds slowly 
immediately after power-up.

Run Computer Setup and increase the POST Delay in 
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing 
message.

System is trying to start from a 
non-bootable diskette.

Remove the diskette from the diskette drive.

System files missing or not 
properly installed.

1. Insert a bootable system diskette and restart.
2. Verify hard drive is partitioned and formatted. 
3. Install system files for the appropriate operating system, 

if necessary.

Hard drive boot disabled in 
Computer Setup.

Run Computer Setup and enable the hard drive entry in the 
Storage Options list.

Workstation does not start. Hard drive is damaged. Observe the beeps and LED lights on the front of the 
workstation. Refer to section 5.8 “Power On Self Test 
(POST) and Error Messages”.
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5.7.5 Solving Display Problems

Table 5-7 Display Problems

Problem Cause Solution

Blank screen (no video). The cable connections are not 
correct.

Check the cable connections from the monitor to the 
workstation and to a working electrical outlet.

The monitor is off. Switch the monitor to on (LED is on). You might need to 
refer to the monitor manual for an explanation of the LED 
signals.

Screen blanking utility installed 
or energy saver features 
enabled.

Press any key or click the mouse button and, if set, enter 
your password.

System ROM is bad; system is 
running in FailSafe Boot Block 
mode (indicated by eight 
beeps).

Reflash the ROM using a ROMPaq diskette.

Computer is in Standby mode. Press the power button to resume from Standby mode.

CAUTION: When attempting to resume from Standby mode, do not hold down the power button for more than four seconds. 
Otherwise, the workstation will shut down and you will lose your data.

Monitor settings in the 
workstation are not compatible 
with the monitor.

1. Restart the workstation and press F8 during startup 
when you see “Press F8” in the bottom-right corner of 
the screen.

2. Using the keyboard arrow keys, select Enable VGA 
Mode and press Enter.

3. In Windows Control Panel, double-click the Display 
icon and select the Settings tab.

4. Use the sliding control to reset the resolution.

The display works properly during 
the POST but goes blank when the 
OS starts.

The display settings in the OS 
are incompatible with your 
graphics card and monitor.

1. Restart your workstation in VGA mode.
2. After the OS starts, change the display settings to 

match those supported by your graphics card and 
monitor. 

3. Refer to your OS and graphics card documentation for 
information on changing display settings.

Monitor does not function properly 
when used with energy saver 
features.

Monitor without energy saver 
capabilities is being used with 
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters. The brightness and contrast 
controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is securely connected to the 
graphics card and the monitor.

Blurry video or requested resolution 
cannot be set.

If the graphics controller was 
upgraded, the correct video 
drivers might not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of 
displaying requested resolution.

Change requested resolution.

The picture is broken up, rolls, jitters, 
or flashes.

The monitor connections might 
be incomplete or the monitor 
might be incorrectly adjusted.

1. Be sure the monitor cable is securely connected to the 
workstation.

2. In a two-monitor system or if another monitor is in close 
proximity, be sure the monitors are not interfering with 
each other’s electromagnetic field by moving them 
apart.

3. Fluorescent lights or fans might be too close to the 
monitor.

Monitor must be degaussed. Degauss the monitor. 

Vibrating or rattling noise coming 
from inside a CRT monitor when 
powered on.

Monitor degaussing coil has 
been activated.

None. It is normal for the degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from inside a 
CRT monitor.

Electronic relays have been 
activated inside the monitor.

None. It is normal for some monitors to make a clicking 
noise when turned on and off, when going in and out of 
Standby mode, and when changing resolutions.
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High-pitched noise coming from 
inside a flat panel monitor.

Brightness and contrast settings 
are too high.

Lower brightness and contrast settings.

Fuzzy focus; streaking, ghosting, or 
shadowing effects; horizontal 
scrolling lines; faint vertical bars; or 
unable to center the picture on the 
screen. (Flat panel monitors using an 
analog VGA input connection only.)

Flat panel monitor’s internal 
digital conversion circuits might 
be unable to correctly interpret 
the output synchronization of the 
graphics card.

1. Select the monitor’s Auto-Adjustment option in the 
monitor’s on-screen display menu.

2. Go to the HP Support Web site and check for an 
updated display driver.

Certain typed symbols do not 
appear correct.

The font you are using does not 
support that particular symbol.

Use the Character Map to locate the and select the 
appropriate symbol. Click Start > All Programs > 
Accessories > System Tools > Character Map. You 
can copy the symbol from the Character Map into 
a document.

Table 5-7 Display Problems (continued)

Problem Cause Solution
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5.7.6 Solving Audio Problems

Table 5-8 Audio Problems

Problem Cause Solution

Sound does not come out of the 
speaker or headphones.

Software volume control is 
turned down.

Double-click the Speaker icon on the taskbar and use the 
volume slider to adjust the volume.

The external speakers are not 
turned on.

Turn on the external speakers.

External speakers plugged into 
the wrong audio jack.

See the sound card documentation for proper speaker 
connection.

Audio cable is not connected. Connect the audio cable between the CD or DVD-ROM 
drive and the system board.

Digital CD audio is not enabled. Enable digital CD audio:
1. Open the Control Panel and select System.
2. On the Hardware tab, click the Device Manager 

button.
3. Right-click the CD/DVD device and select 

Properties.
4. On the Properties tab, be sure “Enable digital CD 

audio for this CD-ROM device” is selected.

Headphones or devices 
connected to the line-out 
connector mute the internal 
speaker.

Turn on and use headphones or external speakers, if 
connected, or disconnect headphones or external 
speakers.

Volume is muted. 1. Open the Control Panel, click Sound, Speech and 
Audio Devices, then click Sounds and Audio 
Devices.

2. Deselect the Mute checkbox.

Computer is in Standby mode. Press the power button to resume from Standby mode.

CAUTION: When attempting to resume from Standby mode, do not hold down the power button for more than four seconds. 
Otherwise, the workstation will shut down and you will lose your data.

Noise or no sound comes out of the 
speakers or headphones.

1. If using digital speakers that have a stereo jack and 
want the system to auto-switch to digital, use a stereo-
to-mono adapter to properly engage the auto-sense 
feature or use the multimedia device properties 
to manually switch the audio signal from analog to 
digital.

2. If the headphones have a mono jack, use the 
multimedia device properties to switch the system to 
analog out.

NOTE: If you set digital as the Output Mode, the internal speaker and external analog speakers will no longer output audio until 
you switch back to an auto-sense or analog mode.

If you set analog as the Output Mode, external digital speakers will not function until you change the output mode back to an auto-
sense or digital mode.

Sound cuts in and out. Processor resources are being 
used by other open 
applications.

Shut down all open processor-intensive applications.

Workstation appears to be locked 
up while recording audio.

The hard disk might be full. 1. Before recording, be sure there is enough free space 
on the hard disk. 

2. Try recording the audio file in a compressed format.
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5.7.7 Solving Printer Problems

Table 5-9 Printer Problems

Problem Cause Solution

Printer does not print. Printer is not turned on and 
online.

Turn the printer on and be sure it is online.

Printer is out of paper. Add paper to printer.

The correct printer driver for the 
application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:

DIR C:\ > [printer port]

where [printer port] is the address of the printer 
being used. If the printer works, reload the printer 
driver.

If you are on a network, you 
might not have made the 
connection to the printer.

Make the proper network connections to the printer.

Printer might have failed. Run printer self-test.

Printer does not turn on. The cables might not be 
connected properly.

Reconnect all cables.

Printer prints garbled information. The correct printer driver is not 
installed.

Install the correct printer driver for the application.

The cables might not be 
connected properly.

Reconnect all cables.

Printer memory might be 
overloaded.

Reset the printer by turning it off for one minute, then turn it 
back on.
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5.7.8 Solving Keyboard and Mouse Problems
Table 5-10 Keyboard and Mouse Problems

Problem Cause Solution

Keyboard commands and typing are 
not recognized by the workstation.

Keyboard connector is not 
properly connected.

1. Shut down the workstation.
2. Reconnect the keyboard to the back of the workstation 

and restart the workstation.

Program in use has stopped 
responding to commands.

Shut down the workstation using the mouse and then 
restart the workstation.

Keyboard needs repairs. Replace the keyboard.

Keyboard key is stuck down. Remove any debris from the keyboard.

Workstation is in Standby mode. Press the power button to resume from Standby mode.

WARNING: When attempting to resume from Standby mode, do not hold down the power button for more than four seconds. 
Otherwise, the workstation will shut down and you will lose your data.

Cursor will not move using the arrow 
keys on the keypad.

The Num Lock key might be 
on.

Press the Num Lock key. The Num Lock light should not 
be on if you want to use the arrow keys. The Num Lock 
key can be disabled (or enabled) in Computer Setup.

Mouse does not respond to 
movement or is too slow.

Mouse connector is not properly 
plugged into the back of the 
workstation.

1. Shut down the workstation using the keyboard.
2. Plug the mouse connector into the PS/2 mouse 

connector slot in the workstation and restart the 
workstation.

You need to increase mouse 
acceleration.

1. In Windows, click Start > Control Panel and 
double-click Mouse.

2. Select the Motion tab and adjust the speed. 

Program in use has stopped 
responding to commands.

Shut down the workstation using the keyboard and then 
restart the workstation.

Mouse needs repairs. Replace the mouse.

Workstation is in Standby mode. Press the power button to resume from Standby mode.

CAUTION: When attempting to resume from Standby mode, do not hold down the power button for more than four seconds. 
Otherwise, the workstation will shut down and you will lose your data.

Mouse will only move vertically or 
horizontally, or movement is jerky.

Mouse roller ball is dirty. Remove roller ball cover from the bottom of the mouse and 
clean it.
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5.7.9 Solving Front Panel Component Problems
If you are experiencing problems with one of the front panel ports, you might be able to try your device in the 
corresponding port on the back side of the computer. If this does not fix the problem, or you must use the front panel 
ports, continue troubleshooting. 

Some problems in this section are also discussed in other troubleshooting suggestions in this chapter.

Table 5-11 Front Panel Component Problems

Problem Cause Solution

A USB device, headphone, or 
microphone is not recognized by the 
workstation.

It is not properly connected. Reconnect the device to the front of the workstation and 
restart the workstation.

The device does not have 
power.

If the USB device requires AC power, be sure one end is 
connected to the device and one end is connected to a live 
outlet.

The correct device driver is not 
installed.

1. Install the correct driver for the device.
2. You might need to reboot the workstation.

The cable from the device to the 
computer does not work.

If possible, replace the cable.

The device is not working. Replace the device.

A USB, audio, and IEEE-1394 
devices are not working. 

The internal cables might not be 
connected to the system board 
or the PCI card.

1. Turn off the workstation.
2. Connect the cables correctly. 

A device in the IEEE-1394 port is not 
responsive.

Cables of new external device 
are loose or power cables are 
unplugged.

Be sure that all cables are properly and securely 
connected.

The power switch on the device 
is not turned on. 

Turn off the workstation, turn on the external device, then 
turn on the workstation to integrate the device with the 
workstation system.
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5.7.10 Solving Hardware Installation Problems
You might need to reconfigure the workstation when you add or remove hardware, such as an additional diskette drive. 
If you install a PnP device, Windows XP automatically recognizes the device and configures the workstation. If you install 
a non-PnP device, you must reconfigure the workstation after completing installation of the new hardware. In Windows 
XP, use the Add Hardware Wizard and follow the on-screen instructions.

Table 5-12 Hardware Installation Problems

Problem Cause Solution

A new device is not recognized as 
part of the system.

Device is not seated or 
connected properly.

Be sure that the device is properly and securely connected 
and that pins in the connector are not bent down.

Cables of new external device 
are loose or power cables are 
unplugged.

Be sure that all cables are properly and securely connected 
and that pins in the cable or connector are not bent down.

Power switch of new external 
device is not turned on.

Restart the workstation, turn on the external device, then 
turn on the workstation to integrate the device with the 
workstation system.

When the system advised you of 
changes to the configuration, 
you did not accept them.

Reboot the workstation and follow the instructions for 
accepting the changes.

A PnP board might not 
automatically configure when 
added if the default 
configuration conflicts with other 
devices.

Use Windows XP Device Manager to deselect the 
automatic settings for the board and choose a basic 
configuration that does not cause a resource conflict. You 
can also use Computer Setup to reconfigure or disable 
devices to resolve the resource conflict.

Device hardware is not properly 
jumpered or otherwise 
configured.

Read the device-specific configuration information and 
check for incorrect settings or conflicts with other devices 
already installed in the system.

Workstation will not start. Wrong memory modules were 
used in the upgrade or memory 
modules were installed in the 
wrong location.

1. Review the documentation that came with the system to 
determine if you are using the correct memory modules 
and to verify the proper installation.

2. Observe the beeps and LED lights on the front of the 
workstation. Refer to section 5.8 “Power On Self Test 
(POST) and Error Messages” to determine possible 
causes.
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5.7.11 Solving Network Problems
These guidelines do not discuss the process of debugging the network cabling.

Table 5-13 Network Problems

Problem Cause Solution

Wake-on-LAN feature is not 
functioning.

Wake-on-LAN is not enabled. Use the Network control application to enable Wake-on-
LAN.

Network driver does not detect 
network controller.

Network controller is disabled. Run Computer Setup and enable network controller.

Incorrect network driver. Check the network controller documentation for the 
correct driver or obtain the latest driver from the 
manufacturer’s Web site.

Network status link light does not 
turn on or it never flashes.
The network status light should 
flash when there is network 
activity.

No active network is detected. Check cabling and network equipment for proper 
connection.

Network controller is not set up 
properly.

Use the Network control application to verify that the 
device is working properly.

Network driver is not properly 
loaded.

Reinstall network drivers.

System cannot autosense the 
network.

Disable auto-sensing capabilities and force the system 
into the correct operating mode.

Diagnostics reports a failure. The cable is not securely connected. Be sure that both ends of the data cable are securely 
connected. 

The cable is attached to the 
incorrect connector.

Be sure that the cable is attached to the correct connector.

There is a problem with the cable or 
a device at the other end of the 
cable.

Be sure that the cable and device at the other end are 
operating correctly.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, change the 
resource settings for the board.

The network controller is defective. Replace the NIC.

Diagnostics passes, but the 
workstation does not communicate 
with the network.

Network drivers are not loaded, or 
driver parameters do not match 
current configuration.

1. Be sure the network drivers are loaded and that the 
driver parameters match the configuration of the 
network controller.

2. Be sure the correct network client and protocol is 
installed.

The network controller is not 
configured for this workstation.

Select the Network icon in the Control Panel and 
configure the network controller.

Network controller stopped 
working when an expansion 
board was added to the 
workstation.

Network controller interrupt is 
shared with an expansion board.

Under the Computer Setup Advanced menu, change the 
resource settings for the board.

The network controller requires 
drivers.

Verify that the drivers were not accidentally deleted when 
the drivers for a new expansion board were installed.

The expansion board installed is a 
network card (NIC) and conflicts 
with the embedded NIC.

Under the Computer Setup Advanced menu, change the 
resource settings for the board.

Network controller stops working 
without apparent cause.

The files containing the network 
drivers are corrupted.

Reinstall the network drivers, using the Restore Plus! CD.

The cable is not securely connected. Be sure that both ends of the cable are securely attached 
to the correct devices.

The network controller is defective. Replace the NIC.

New network card will not boot. New network card might be 
defective or might not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the 
boot sequence to boot from another source.

Cannot connect to network server 
when attempting Remote System 
Installation.

The network controller is not 
configured properly.

Verify Network Connectivity, that a DHCP Server is 
present, and that the Remote System Installation Server 
contains the NIC drivers for your NIC.
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System setup utility reports 
unprogrammed EEPROM.

Unprogrammed EEPROM. Flash the ROM. See section 3.2.4 “ROM Flash”.

Table 5-13 Network Problems (continued)

Problem Cause Solution
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5.7.12 Solving Memory Problems

CAUTION: For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory. 
Otherwise, the system will not boot the operating system.

Table 5-14 Memory Problems

Problem Cause Solution

System will not boot or does not 
function properly after installing 
additional memory modules.

Memory module is not the 
correct type or speed or the new 
memory module is not seated 
properly.

Replace module with the correct industry-standard device 
for the workstation.

On some models, ECC and non-ECC memory modules 
cannot be mixed.

Out of memory error. Memory configuration might not 
be set up correctly.

Use the Device Manager to check memory configuration.

You have run out of memory to 
run the application.

Check the application documentation to determine the 
memory requirements.

Memory count during POST is 
wrong.

The memory modules might not 
be installed correctly.

Check that the memory modules have been installed 
correctly and that proper modules are used.

Insufficient memory error during 
operation.

Too many Terminate and Stay 
Resident programs (TSRs) are 
installed.

Delete any TSRs that you do not need.

You have run out of memory for 
the application.

Check the memory requirements for the application or add 
more memory to the workstation.

Beeps and power LED flashes RED 
five times.

Memory is installed incorrectly 
or is bad.

1. Reseat DIMMs. 
2. Replace DIMMs one at a time to isolate the faulty 

module.
3. Replace third-party memory with HP memory.
4. Replace the system board.

More than 2GB of RAM is installed, 
yet the 32-bit OS only sees 2GB.

Memory remapping is enabled. Enter Computer Setup (F10) and disable memory 
remapping: Advanced > Chipset/Memory.

A total of 4GB of RAM is installed, 
yet the 32-bit OS only sees about 
3GB.

A 32-bit OS is limited by 4GB of 
address space, and some of 
space is used by 
I/O devices.

Your options are limited. You might try using a video card 
that uses less on-board memory.

A 64-bit OS does not see all 
installed memory.

Memory remapping is disabled. Enter Computer Setup (F10) and enable memory 
remapping: Advanced > Bus Options > Memory 
Remapping.
System Diagnostics and Troubleshooting116



Sy
ste

m
 D

ia
gn

os
tic

s 
an

d 
Tr

ou
bl

es
ho

ot
in

g 
5.7.13 Solving Processor Problems
.

Table 5-15 Processor Problems

Problem Cause Solution

Poor performance is experienced. Processor is hot. 1. Be sure the airflow to the workstation is not blocked.
2. Be sure the fans are connected and working properly 

(some fans only operate when needed).
3. Be sure the CPU heatsink is installed properly.

Power LED is RED and stays on. Processor is not seated properly 
or not installed.

1. Check to see that the processor is present.
2. Reseat the processor.
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5.7.14 Solving CD-ROM and DVD Problems

Table 5-16 CD-ROM and DVD Problems

Problem Cause Solution

System will not boot from CD-ROM 
or DVD drive.

The CD-ROM or DVD boot is not 
enabled through the Computer 
Setup utility.

Run the Computer Setup utility and enable booting to 
removable media and verify boot order settings.

Non-bootable CD in drive. Try a bootable CD in the drive.

CD-ROM or DVD devices are not 
detected or driver is not loaded.

Drive is not connected properly 
or not properly configured.

1. Reconnect power and data cables to the drive.
2. Install correct device driver.

Movie will not play in the DVD drive. Movie might be regionalized for 
a different country.

See the documentation that came with the DVD drive.

Decoder software is not 
installed.

Install decoder software.

Cannot eject compact disc (tray-load 
unit).

Disc not properly seated in the 
drive.

1. Shut down the workstation and insert a thin metal rod 
into the emergency eject hole and push firmly. 

2. Slowly pull the tray out from the drive until the tray is 
fully extended, then remove the disc.

CD-ROM, CD-RW, DVD-ROM, or 
DVD-R/RW drive cannot read a disc 
or takes too long to start.

CD has been inserted upside 
down.

Re-insert the CD with the label facing up.

The DVD-ROM drive takes 
longer to start because it has to 
determine the type of media 
played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive 
determine the type of media being played. If the disc still 
does not start, read the other solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD cleaning kit.

Windows does not detect the 
CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device 
in question.

2. Restart the workstation and let Windows detect the 
device.

Recording audio CDs is difficult or 
impossible.

Wrong or poor quality media 
type.

1. Try using a slower recording speed.
2. Verify that you are using the correct media for the drive.
3. Try a different brand of media. Quality varies widely 

between manufacturers.
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5.7.15 Solving Internet Access Problems

Table 5-17 Internet Access Problems

Problem Cause Solution

Unable to connect to the Internet. Internet Service Provider (ISP) 
account is not set up properly.

Verify Internet settings or contact the ISP for assistance.

Modem is not set up properly. Reconnect the modem. Verify the connections are correct 
using the quick setup documentation.

Web browser is not set up 
properly.

Verify that the Web browser is installed and set up to work 
with your ISP.

Cable/DSL modem is not 
plugged in.

Plug in cable/DSL modem. You should see a “power” LED 
light on the front of the cable/DSL modem.

Cable/DSL service is not 
available or has been 
interrupted due to bad weather.

Try connecting to the Internet at a later time or contact your 
ISP. (If the cable/DSL service is connected, the “cable” LED 
light on the front of the cable/DSL modem will be on.)

The network cable is 
disconnected.

Connect the network cable between the cable modem and 
the workstation’s RJ-45 connector. (If the connection works, 
the “PC” LED light on the front of the cable/DSL modem 
will be on.)

IP address is not configured 
properly.

Contact the ISP for the correct IP address.

Cookies are corrupted. In Windows, open the Control Panel and double-click 
Internet Options. On the General tab, click the Delete 
Cookies button.

Cannot automatically launch Internet 
programs.

You must log on to the ISP 
before some programs will start.

Log on to the ISP and launch the desired program.

Internet takes too long to download 
Web sites.

Modem is not set up properly. Verify that the correct modem speed and COM port are 
selected.
For Windows:
1. Open the Control Panel.
2. Double-click System.
3. Select the Hardware tab.
4. In the Device Manager area, click the Device 

Manager button.
5. Double-click Ports (COM & LPT).
6. Right-click the COM port your modem uses, then click 

Properties.
7. Under Device status, verify that the modem is working 

properly.
8. Under Device usage, verify the modem is enabled.
9. If there are further problems, click the Troubleshoot 

button and follow the on-screen instructions.
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5.8 Power On Self Test (POST) and Error Messages
POST is a series of diagnostic tests that runs automatically when the system is turned on. An audible, visual, or both 
message occurs if the POST encounters a problem. POST checks the following items to ensure that the workstation system 
is functioning properly:

• Keyboard
• Memory modules
• Diskette drives
• All SATA and SCSI mass storage devices 
• Processors
• Controllers

NOTE: If the Power-On Password is set, a key icon appears on the screen while POST is running. You must enter the 
password before continuing.

Table 5-18 POST Error Messages

Screen Message Probable Cause Recommended Action

101—Option ROM Error System ROM checksum. Verify the correct ROM.
1. Flash the ROM, if needed.
2. If an expansion card was recently added, remove it 

and see if the problem remains. 
3. Clear CMOS.
4. If the message disappears, there might be 

a problem with the expansion card.
5. Replace the system board.

102—System Board Failure DMA, timers, etc. 1. Clear CMOS.
2. Remove expansion boards.
3. Replace the system board.

110—Out of Memory for 
Option ROMs

Option ROM for a device was unable to 
run due to memory constraints.

Run Computer Setup and disable unneeded devices 
from Advanced > Onboard Devices. Or, disable 
option ROMs from Advanced > Device Options.

162—System Options Not Set Configuration incorrect. RTC battery 
might need to be replaced.

1. Run Computer Setup (F10 Setup).
2. Set the date and time under Control Panel or in F10 

Setup depending on the operating system.
3. If the problem persists, replace the RTC battery.

163—Time and Date Not Set Invalid time or date in configuration 
memory.
RTC (real-time clock) battery might need 
to be replaced.
CMOS jumper might not be properly 
installed.

1. Set the date and time under Control Panel or in F10 
Setup depending on the operating system.

2. If the problem persists, replace the RTC battery.

164—Memory Size Error Memory configuration is incorrect. 1. Run Computer Setup (F10 Setup) or Windows 
utilities.

2. Be sure memory modules are installed properly.
3. If third-party memory has been added, test using HP 

only memory.
4. Verify proper memory module type.

201—Memory Error RAM failure. 1. Run Computer Setup (F10 Setup) or Windows 
utilities.

2. Be sure that memory modules are installed correctly.
3. Verify proper memory module type.
4. Remove and replace memory module(s) one at a 

time to isolate faulty module.
5. Replace the faulty memory module(s).
6. If error persists after replacing memory modules, 

replace the system board.

202—Memory Type Mismatch Memory modules do not match each 
other.

Replace memory modules with matched sets.
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207—ECC Corrected Single Bit 
Errors in Memory Socket(s) y,y

Single Bit ECC error. 1. Verify proper memory module type.
2. Try another memory socket.
3. Replace memory module if problem persists.

212—Failed Processor Processor has failed to initialize. 1. Reseat the processor in its socket.
2. If the processor does not respond, replace it.

213—Incompatible memory 
Module in memory Socket(s) 
X,X, X

A memory module in memory socket 
identified in the error message is missing 
critical SPD information, or is 
incompatible with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.
3. Replace memory with a module conforming to the 

SPD standard.

214—DIMM Configuration 
Warning

DIMMs not installed correctly (not 
paired correctly).

Refer to section 4.19 “Memory” for the correct memory 
configurations and reseat the DIMMs accordingly.

215—Memory Mismatch 
Warning

There are one or more mismatched pairs 
of DIMMs between channel A and 
channel B. Some memory has been 
disabled. Install matching pairs.

Refer to section 4.19 “Memory” for the correct memory 
configurations and reseat the DIMMs accordingly.

301—Keyboard Error Keyboard failure. 1. Reconnect keyboard with workstation turned off.
2. Check connector for bent or missing pins.
3. Be sure that none of the keys are pressed.
4. Replace keyboard.

303—Keyboard Controller Error I/O board keyboard controller. 1. Reconnect keyboard with workstation turned off.
2. Replace the system board.

304—Keyboard or System Unit 
Error

Keyboard failure. 1. Reconnect the keyboard with workstation turned off.
2. Be sure that none of the keys are pressed.
3. Replace keyboard.
4. Replace system board. 

402—Parallel Port 2 Address 
Assignment Conflict

IRQ address conflicts with another 
device.

Reset the IRQ.

501—Display Adapter Failure Graphics display controller. 1. Reseat the graphics card (if applicable).
2. If using PCI Express card with auxiliary power 

cable, be sure it is attached.
3. Clear CMOS.
4. Verify that the monitor is attached and turned on.
5. Replace the graphics controller.

510—Splash Screen image 
corrupted

Splash Screen image has errors. Install latest version of ROMPaq to restore image.

511—CPU0 or CPU1 Fan not 
detected

Fan is not connected or might have 
malfunctioned.

1. Reseat fan cable.
2. Reseat the fan.
3. Replace the fan.

512—Chassis, rear chassis, or 
front chassis fan not detected

Fan is not connected, might have 
malfunctioned.

1. Reseat chassis, rear chassis, or front chassis fan 
cable.

2. Reseat chassis, rear chassis, or front chassis fan.
3. Replace chassis, rear chassis, or front chassis fan.

601—Diskette Controller Error Diskette controller circuitry or diskette 
drive circuitry incorrect.

1. Run Computer Setup (F10 Setup).
2. Check and replace cables.
3. Clear CMOS.
4. Replace diskette drive.
5. Replace the system board.

605—Diskette Drive Type Error Mismatch in drive type. 1. Run Computer Setup (F10 Setup).
2. Disconnect any other diskette controller devices 

(tape drives).
3. Clear CMOS.

Table 5-18 POST Error Messages (continued)

Screen Message Probable Cause Recommended Action
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611—Primary Diskette Port 
Address Assignment Conflict

Configuration error. 1. Run Computer Setup (F10 Setup).
2. Remove expansion cards.
3. Clear CMOS.

912—Computer Cover Has 
Been Removed Since Last 
System Start Up

Access panel has been removed. No action required.

917—Front Audio Not 
Connected

The front audio cable is not connected. Connect front audio cable. 

918—Front USB Not Connected Front USB is not connected. Connect front USB cable.

921—Device in PCI Express Slot 
failed to initialize

PCI Express cards not seated properly. Reseat all PCI Express cards in their PCI Express slots. If 
the problem persists, contact the PCI Express card 
vendor.

940—Extended ROM signature 
not found

The signature at the start of the ROM 
flash is missing. Your firmware (BIOS) is 
incomplete. 

Run ROMPaq again.

960—CPU Overtemp occurred The ambient temperature could exceed 
operating limits (maximum=95°F), or 
there are obstructions to airflow, 
including dust build up. 

1. Be sure you are not operating the system in an 
environment that exceeds 95°F.

2. Disconnect power and open the access panel. 
3. Check that cables are not blocking CPU heatsink 

fans or front fan, if installed.
4. Check that there is not excessive dust on major 

components. 
5. If airflow is acceptable and there is not excessive 

dust, the thermal sensing circuitry has failed on the 
processors or on the system board. You must 
replace the processors, system board, or both.

1155—Serial Port Address 
Conflict Detected

Both external and internal serial ports 
are assigned to same IRQ.

1. Remove any Comm port expansion cards.
2. Clear CMOS.
3. Reconfigure card resources and run Computer Setup 

(F10 Setup). Run Computer Setup or Windows 
utilities.

1720 SMART Hard Drive Detect 
Imminent Failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will fix 
an erroneous error message.)

1. Determine if hard drive is giving correct error 
message. Run the Drive Protection System test, if 
applicable.

2. Apply firmware patch if applicable (see 
http://www.hp.com/support).

3. Back up contents and replace hard drive.

1721—SMART SCSI Hard Drive 
detects imminent failure

Hard drive is about to fail. (Some hard 
drives have a firmware patch that will fix 
an erroneous error message.)

1. Determine if hard drive is giving correct error 
message. Run the Drive Protection System test if 
applicable.

2. Apply firmware patch if applicable (see 
http://www.hp.com/support).

3. Back up contents and replace hard drive.

1780—Disk 0 Failure The drive is not installed correctly or has 
failed. 

1. Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2. Verify that the cables are the correct cables for your 
computer model. 

If this message persists, you might need service for your 
workstation.

1781—Disk 1 Failure The drive is not installed correctly or has 
failed. 

1. Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2. Verify that the cables are the correct cables for your 
computer model. 

If this message persists, you may need service for your 
workstation.

Table 5-18 POST Error Messages (continued)

Screen Message Probable Cause Recommended Action
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1782—Disk Controller Failure Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).
2. Clear CMOS.
3. Check cable seating/jumper settings.
4. Run hard drive diagnostics.
5. Disconnect additional drives.
6. Run the Drive Protection System test, if available.
7. Replace the hard drive.
8. Replace the system board.

1790—Disk 0 Error The drive is not installed correctly or has 
failed. 

1. Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2. Verify that the cables are the correct cables for your 
computer model. 

If this message persists, you might need service for your 
workstation.

1791—Disk 1 Error The drive is not installed correctly or has 
failed. 

1. Make sure that any jumpers are set correctly, and 
that power and drive cables are connected, both to 
the drive and the system board. 

2. Verify that the cables are the correct cables for your 
computer model. 

If this message persists, you might need service for your 
workstation.

1792—Secondary Disk 
Controller Failure

Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).
2. Clear CMOS.
3. Check cable seating/jumper settings.
4. Run hard drive diagnostics.
5. Disconnect additional drives.
6. Run the Drive Protection System test, if available.
7. Replace the hard drive.

1793—Secondary Controller or 
Disk Failure

Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).
2. Clear CMOS.
3. Check cable seating/jumper settings.
4. Run hard drive diagnostics.
5. Disconnect additional drives.
6. Run the Drive Protection System test, if available.
7. Replace the hard drive.

1794—Inaccessible devices 
attached to primary IDE 
controller

Devices attached to the primary IDE 
controller are inaccessible while the 
SATA controller is set to “Replace 
Primary IDE Controller” in Setup.

1. Run Computer Setup (F10 Setup).
2. Select Storage > Storage Options and set 

SATA controller to Add as Separate Controller.

1800—Temperature Alert Internal temperature exceeds 
specification.

1. Check that workstation air vents are not blocked 
and cooling fan is running.

2. Verify processor speed selection.
3. Replace the processor.
4. Replace the system board.

1801—Microcode Patch Error Processor not supported by ROM BIOS. Upgrade BIOS to proper version.

1802—Processor Not 
Supported

The system board does not support the 
processor.

Replace the processor with a compatible one.

1803—BIOS Update Needed 
for Processor

This BIOS revision does not support the 
installed processor. 

Install the latest BIOS located at 
http://www.hp.com.

Invalid Electronic Serial Number Electronic serial number has become 
corrupted.

Run Computer Setup. If Setup already has data in the 
field or will not allow the serial number to be entered, 
download from http://www.hp.com and run 
SP5572.EXE (SNZERO.EXE).
Run Computer Setup and try to enter serial number 
under Security, System ID, then save changes.

Table 5-18 POST Error Messages (continued)

Screen Message Probable Cause Recommended Action
123

http://www.hp.com


ECC Multiple Bit Error Detected 
in Memory Module

Chipset has detected more than one 
bad bit in a 64-bit quadword of the 
memory array.

Replace the memory module.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.

Table 5-18 POST Error Messages (continued)

Screen Message Probable Cause Recommended Action
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A SATA Devices
This appendix provides additional information for setting up your SATA hard drives.

• Section A.1 “SATA Guidelines”
• Section A.2 “SATA RAID Configurations”
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A.1 SATA Guidelines

NOTE: These systems support a mixed configuration of SCSI and SATA hard drives. The HP xw4300 Workstation does 
not support IDE hard drives.

When installing and operating SATA devices:

• Connect the SATA hard drive from the system board to the hard drive with the SATA cable (326965-006).
• If using a SATA controller card, connect the 4-4 pin LED cable (included with SATA controller board) from the 

card header “JP1” (4-pin header) to the system board header labeled “HD LED” (4-pin header at P29).

For complete and current information on supported accessories and components, visit 
http://partsurfer.hp.com.

A.2 SATA RAID Configurations
This workstation supports an embedded SATA RAID. Redundant Array of Inexpensive Disks (RAID) combines multiple 
physical drives together to provide either increased performance or increased redundancy.

For an embedded SATA RAID, there are three primary configurations.

• RAID 0 is a striping configuration. For example, this combines two 80GB drives into one 160GB drive. Both 
physical drives can be accessed simultaneously for better performance. This is faster than using two 80GB drives 
separately.

• RAID 1 is a mirroring configuration. For example, this uses two 80GB drives, but one drive is a complete mirror 
of the other drive. The system remains functional and no data is lost if one of the drives should fail.

• RAID 0 + 1 is a combination of RAID 0 and RAID 1. The controller combines the performance of data striping 
(RAID 0) and the fault tolerance of disk mirroring (RAID 1). Data is striped across multiple drives and duplicated 
on another set of drives.

• RAID 5 is data striping with rotating parity. For example, three 80GB drives offer 160GB of usable storage, with 
the third 80GB drive used to store parity information. Data can be fully recovered if any one of the three drives 
fail. 

There are other RAID configurations, but they are not supported on an embedded SATA RAID.

NOTE: For information on the integrated SATA RAID, visit http://www.hp.com/go/workstationsupport and review the 
supplier’s documentation and HP User Manual for the Integrated NVIDIA SATA RAID Array for Microsoft® Windows® 
XP Professional. For information on supported SATA RAID configurations, visit
 http://www.hp.com/go/productbulletin. 
SATA Devices126
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B SCSI Devices
This appendix provides more information for setting up your SCSI hard drive.

• Section B.1 “SCSI Guidelines”
• Section B.2 “Using SCSISelect with SCSI Devices”
• Section B.3 “SMART”
• Section B.4 “Jumpers”
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B.1 SCSI Guidelines
When installing and operating SCSI devices, you must follow these guidelines:

• A wide (68-pin) SCSI controller with two channels, one for internal devices and one for external devices. Five 
internal SCSI devices are supported.

• If multiple SCSI devices are used, split the devices between Channels A and B for optimum performance. Cable 
length for the second channel should not be longer than 18 inches.

CAUTION: Do not route data cables near the air intake to the power supply. Cables routed in this manner can block 
the airflow and cause the workstation to overheat.

• All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed. Refer to section B.4 for more 
information. 

• Every SCSI chain or circuit must be terminated (closed) at both ends. Some system boards have both ends of the 
SCSI cable connected to, and terminated by, the system board. Termination can be accomplished in one of 
several ways:
• Use a cable with a built-in terminator.
• Use a cable with a terminating resistor plug in the last connector.
• Connect a SCSI device with its termination enabled into the last connector.
• Connect an external SCSI device with its termination enabled to the external SCSI connector on the rear 

panel of the workstation.
• Turn on all external SCSI devices before turning on the power to the workstation. This enables the SCSI controller 

to recognize the external devices.

B.2 Using SCSISelect with SCSI Devices
The Ultra160 and faster SCSI host adapters include the SCSISelect utility to configure the host adapter and to run the 
SCSI disk utilities. To run the SCSISelect utility:

NOTE: The onboard LSI SCSI controller on the xw4300 has an “LSI Logic Configuration Utility” that you access 
through Ctrl-C when the LSI option ROM is initializing. 

• In POST Messages Enabled mode: Press Ctrl+A when the “Press<Ctrl><A> for SCSISelect Utility” message 
appears during POST. The utility will only be present if an Adaptec SCSI card is present.

• In POST Messages Disabled mode: When the HP logo screen appears, press any key to exit the logo screen. 
Immediately after exiting the logo screen, press Ctrl+A to access the SCSISelect utility. The utility will only be 
present if an Adaptec SCSI card is present.

A menu appears with the following options:

• Configure/View Host Adapter Settings
• SCSI Bus Interface Definitions

• Host Adapter SCSI ID
• SCSI Parity Checking
• Host Adapter SCSI Termination

• Additional Options
• Boot Device Options
• SCSI Device Configuration
• Advanced Configuration Options

• SCSI Disk Utilities
• Lists all SCSI devices and SCSI ID numbers

NOTE: For additional information about configuring POST message display status, refer to section 3.1.3 “Computer 
Setup Menu”.

B.3 SMART
The SMART SCSI hard drives for HP workstations have built-in drive failure prediction that warns the user or the network 
administrator of an impending failure or crash of the hard drive. SMART drives track fault prediction and failure 
indication parameters, such as re-allocated sector count, spin retry count, and calibration retry count. If the drive 
determines that a failure is imminent, it generates a fault alert.
SCSI Devices128



SC
SI

 D
ev

ic
es

 

B.4 Jumpers
All SCSI controllers require a unique SCSI ID (0–15) for each SCSI device installed.

The controller identifies a SCSI device by its SCSI ID number rather than its location. Moving a SCSI device from one 
position to another on the SCSI chain does not affect communication between the controller and the device. The reserved 
and available SCSI ID numbers are displayed in the following list:

• 0 is reserved for the primary hard drive (Windows only).
• 7 is reserved for the SCSI controller.
• 1 through 6 and 8 through 15 are available for all other SCSI devices.

When 0 is used for the primary hard drive, set the second hard drive to 1, the third to 2, and so on.

To set the SCSI ID on a drive, see the instructions on top/back of the hard drive for the correct jumper settings. The drive 
probably displays a diagram of the jumper block. This diagram shows you which blocks to cover with your jumper to 
get the desired ID.

For example, if the drive must be set to 3, the drive might show that the 4 ID bits are at the far left of the connector (ID0, 
ID1, ID2, and ID3), then using the jumpers provided, cover the pins to set the SCSI ID.
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C Connector Pins
This appendix provides pin information for your system:

• Section C.1 “Enhanced Keyboard”
• Section C.2 “Mouse”
• Section C.3 “Ethernet RJ-45”
• Section C.4 “Serial Interface”
• Section C.5 “USB”
• Section C.6 “IEEE 1394”
• Section C.7 “Microphone”
• Section C.8 “Headphone”
• Section C.9 “Line-in Audio”
• Section C.10 “Line-out Audio”
• Section C.11 “Ultra SCSI”
• Section C.12 “SATA”
• Section C.13 “Monitor (VGA)”
• Section C.16 “24-Pin Power (Main)”
• Section C.17 “4-Pin Power (for Processors)”
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C.1 Enhanced Keyboard

C.2 Mouse

C.3 Ethernet RJ-45

C.4 Serial Interface

C.5 USB

Keyboard Connector Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Mouse Connector Pin Signal

1
2
3

Data
Unused
Ground

4
5
6

+5 VDC
Clock
Unused

Ethernet Connector Pin Signal

1
2
3
4

(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused

5
6
7
8

Unused
(-) Receive Data
Unused
Unused

Serial Connector Pin Signal

1
2
3

Carrier Detect
Receive Data
Transmit Data

4
5
6

Data Terminal Ready
Signal Ground
Data Set Ready

7
8
9

Request to Send
Clear to Send
Ring Indicator

USB Connector Pin Signal

1
2
3
4

+5 VDC
- Data
+ Data
Ground
Connector Pins132
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C.6 IEEE 1394

C.7 Microphone

C.8 Headphone

C.9 Line-in Audio

C.10 Line-out Audio

IEEE 1394 Connector Pin Signal

1 power

2 gnd

3 tpb-

4 tpb+

5 tpa-

6 tpa+

Microphone Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio
Power
Ground

Headphone Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_Left
Audio_Right
Ground

Line-in Audio Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_In_Left
Audio_In_Right
Ground

Line-out Audio Connector (1/8 inch) Pin Signal

1 (Tip)
2 (Ring)
3 (Shield)

Audio_Out_Left
Audio_Out_Right
Ground
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C.11 Ultra SCSI
Ultra SCSI 80-pin connector

Pin  Signal Pin Signal

1 12V 41 12V GROUND 

2 12V 42 12V GROUND 

3 12V 43 12V GROUND 

4 12V 44 MATED 1 

5 3.3V 45 3.3V CHARGE 

6 3.3V 46 DIFFSNS 

7 -DB(11) 47 +DB(11) 

8 -DB(10) 48 +DB(10) 

9 -DB(9) 49 +DB(9) 

10 -DB(8) 50 +DB(8) 

11 -I/O 51 +I/O 

12 -REQ 52 +REQ 

13 -C/D 53 +C/D 

14 -SEL 54 +SEL 

15 -MSG 55 +MSG 

16 -RST 56 +RST 

17 -ACK 57 +ACK 

18 -BSY 58 +BSY 

19 -ATN 59 +ATN 

20 -P_CRCA 60 +P_CRCA 

21 -DB(7) 61 +DB(7) 

22 -DB(6) 62 +DB(6) 

23 -DB(5) 63 +DB(5) 

24 -DB(4) 64 +DB(4) 

25 -DB(3) 65 +DB(3) 

26 -DB(2) 66 +DB(2) 

27 -DB(1) 67 +DB(1) 

28 -DB(0) 68 +DB(0) 

29 -DB(P1) 69 +DB(P1) 

30 -DB(15) 70 +DB(15) 

31 -DB(14) 71 +DB(14) 

32 -DB(13) 72 +DB(13) 

33 -DB(12) 73 +DB(12) 

34 5V 74 MATED 2 

35 5V 75 5V GROUND 

36 5V CHARGE 76 5V GROUND 
Connector Pins134
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C.12 SATA

C.13 Monitor (VGA)

NOTE: Monitor connectors can vary depending on your configuration. 

37 SPINDLE SYNC 77 ACTIVE LED OUT 

38 RMT_START 78 DLYD_START 

39 SCSI ID (0) 79 SCSI ID (1) 

40 SCSI ID (2) 80 SCSI ID (3) 

Ultra SCSI 80-pin connector

Pin  Signal Pin Signal

SATA Connector

Pin Signal Pin Signal Pin Signal

Data Cable Power Cable Power Cable

S-1 Ground P-1 3.3-V power P-8 5-V power

S-2* A+ P-2 3.3-V power P-9 5-V power

S-3* A- P-3 3.3-V power P-10 Ground

S-4 Ground P-4 Ground P-11 Reserved

S-5** B- P-5 Ground P-12 Ground

S-6** B+ P-6 Ground P-13 12-V power

S-7 Ground P-7 5-V power P-14 12-V power

* S2 and S3 differential signal pair
**S5 and S6 differential signal pair

P-15 12-V power

VGA Connector 

Pin Signal Pin Signal Pin Signal

1
2
3

Red Analog
Green Analog
Blue Analog

6
7
8

Ground
Ground
Ground

11
12
13

Monitor ID
DDC Serial Data
Horizontal Sync

4
5

Monitor ID
Ground

9
10

+5V DC
Ground

14
15

Vertical Sync
DDC Serial Clock
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C.14 Monitor (DVI)

NOTE: Monitor connectors can vary depending on your configuration. 

DVI Connector

Pin Signal Pin Signal

1 T.M.D.S DATA 2- 16 HOT PLUG DETECT 

2 T.M.D.S DATA 2+ 17 T.M.D.S DATA 0- 

3 T.M.D.S DATA 2/4 SHIELD 18 T.M.D.S DATA 0+ 

4 T.M.D.S DATA 4- 19 T.M.D.S DATA 0/5 SHIELD 

5 T.M.D.S DATA 4+ 2 0 T.M.D.S DATA 5- 

6 DDC CLOCK 21 T.M.D.S DATA 5+ 

7 DDC DATA 22 T.M.D.S CLOCK SHIELD 

8 ANALOG VERT. SYNC 23 T.M.D.S CLOCK+ 

9 T.M.D.S DATA 1- 24 T.M.D.S CLOCK- 

10 T.M.D.S DATA 1+     C1 ANALOG RED

11 T.M.D.S DATA 1/3 SHIELD C2 ANALOG GREEN

12 T.M.D.S DATA 3- C3 ANALOG BLUE 

13 T.M.D.S DATA 3+ C4 ANALOG HORZ SYNC

14  +5V POWER C5 ANALOG GROUND 

15  GND 
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C.15 ATA/ATAPI (IDE) Standard Drive Cable

C.16 24-Pin Power (Main)

C.17 4-Pin Power (for Processors)

ATA/ATAPI (IDE) Connector

Pin Signal Pin Signal Pin Signal

1
2
3
4
5

Reset
Ground
DD7
DD8
DD6

15
16
17
18
19

DD1
DD14
DD0
DD15
Ground

29
30
31
32
33

DMAK
Ground
INTRQ
IOCS16
DA1

6
7
8
9
10

DD9
DD5
DD10
DD4
DD11

20
21
22
23
24

(Key)
DMARQ
Ground
DIOW
Ground

34
35
36
37
38

PDIAG (cable detect)
DA0
DA2
CS1FX
CS3FX

11
12
13
14

DD3
DD12
DD2
DD13

25
26
27
28

DIOR
Ground
IORDY
CSEL

39
40

DASP
Ground

24-Pin Main Power Connector

1
2
3
4
5
6
7

+3.3 V
+3.3 V
GND
+5 V
GND
+5 V
GND

8
9
10
11
12
13

POK
+5 Vaux
+12 V-A
+12 V-A
+3.3 V
+3.3 V and 
+3.3V-Rsense

14
15
16
17
18
19
20

-12 V
GND
PS_ON_L
GND
GND
GND

21
22

23
24

+5 V
+5 V and
+5 V-Rsense
+5 V
GND

1 12

13 24

4-Pin Power (for CPUs) Pin Output AWG Wire Color

1 GND 18 Black

2 GND 18 Black

3 V12-CPU 18 White

4 V12-CPU 18 White
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D System Board Designators
This appendix lists the system board designators for this system.

Table D-19 System Board Designators

Designator Silkscreen Component

MH01-MH10 N/A Mounting holes

CR1 5V_AUX LED: 5V_AUX power indicator

N/A N/A Power LED

E14 N/A Boot block header/jumper

E49 N/A Clear password header/jumper

J41 SLOT1 PCI-E X16 PCI Express slot 

J20 SLOT2 PCI PCI slot

J32 SLOT3 PCI-E X8’ (X4) PCI Express slot

J31 SLOT4 PCI-E X1 PCI Express slot

J21 SLOT5 PCI PCI slot

J22 SLOT6 PCI PCI slot

J50 PARALLEL Parallel port

J68 KBD_MSE Stacked keyboard/mouse connector

J9 RJ/USB Stacked RJ45/Dual USB

J10 QUAD USB Quad stacked USB

J83 AUDIO Triple stacked audio jack

P1 P/S Power supply connector (24 pin)

P3 N/A Processor 12V header

P10 FDD Diskette drive connector

P11 AUX-IN Auxiliary audio connector

P124 HOOD LOCK Hood lock header

P125 HD SENSE Hood sensor header

P20 IDE Primary IDE connector

P23 FRONT AUDIO Front panel audio header

P24 FRONT USB Front panel USB header

P29 HDD LED HDD LED connector

P60 SATA0 Primary serial ATA (SATA) connector

P61 SATA1 Second serial ATA (SATA) connector

P62 SATA2 Third serial ATA (SATA) connector

P63 SATA3 Fourth serial ATA (SATA) connector

P5 CONTROL PANEL Main power/HDD LED connector

P52 SERIAL B Flying serial port header

P53 SERIAL A Serial port

P6 SPK Speaker connector

P70 CPU FAN CPU fan header 

P8 SYS FAN Primary chassis fan header

P9 PCI FAN Secondary chassis fan header

SW50 CMOS Clear CMOS switch/push button
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XBT2 BATTERY Battery retainer

XMM1 DIMM1 Memory slot

XMM2 DIMM2 Memory slot

XMM3 DIMM3 Memory slot

XMM4 DIMM4 Memory slot

XU1 CPU Processor socket

Table D-19 System Board Designators

Designator Silkscreen Component
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E Power Cord Set Requirements
The power supplies on some computers have external power switches. The voltage select switch feature on the computer 
permits it to operate from any line voltage between 100–120 or 220–240 volts AC. Power supplies on those computers 
that do not have external power switches are equipped with internal switches that sense the incoming voltage and 
automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you purchased the 
equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the computer. For 
more information on power cord set requirements, contact your authorized HP dealer, reseller, or service provider.

E.1 General Requirements
The requirements listed below are applicable to all countries: 

• The power cord must be approved by an acceptable accredited agency responsible for evaluation in the country 
where the power cord set will be installed. 

• The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage rating 
of 125 or 250 volts AC, as required by each country’s power system. 

• The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord must be 
between 1.8 m (6 feet) and 3.6 m (12 feet).
The power cord should be routed so that it is not likely to be walked on or pinched by items placed upon it or 
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits from 
the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in any 
manner, replace it immediately.

E.1.1 Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.

E.1.2 Country-Specific Requirements
Additional requirements specific to a country are shown in parentheses and explained below. 

Country Accrediting
Agency

Country Accrediting
Agency

Australia (1)
Austria (1)
Belgium (1) 
Canada (2)

EANSW
OVE
CEBC
CSA

Italy (1)
Japan (3)
Norway (1)
Sweden (1)

IMQ
METI
NEMKO
SEMKO

Denmark (1)
Finland (1) 
France (1) 
Germany (1) 

DEMKO
SETI
UTE
VDE

Switzerland (1)
United Kingdom (1)
United States (2)

SEV
BSI
UL

1. The flexible cord must be <HAR> Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings 
(appliance coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the 
country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole 
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the 
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must 
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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F Routine Care
This appendix contains the additional information for caring for your system:

• Section F.1 “General Cleaning Safety Precautions”
• Section F.2 “Maximizing the Airflow”
• Section F.3 “Cleaning the Workstation Case”
• Section F.4 “Cleaning the Keyboard”
• Section F.5 “Cleaning the Monitor”
• Section F.6 “Cleaning the Mouse”
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F.1 General Cleaning Safety Precautions
• Never use solvents or flammable solutions to clean the workstation.
• Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use the cloth 

on the component.
• Always unplug the workstation when cleaning with liquids or damp cloths.
• Always unplug the workstation before cleaning the keyboard, mouse, or air vents.
• Disconnect the keyboard before cleaning it.
• Wear safety glasses equipped with side shields when cleaning the keyboard.

F.2 Maximizing the Airflow
Keep your workstation in an area where the airflow to the front and rear of the system is not obstructed.

• If possible, keep the unit off of surfaces where dust can gather.
• Keep the back of the unit at least 6 inches away from a wall or other obstruction.
• Keep the front of the unit clear of any obstruction that keeps air from entering the front of the system.
• Remove any dust on the front panel (vent area) and the rear fans with a small vacuum, compressed 

air, or dust rag.

F.3 Cleaning the Workstation Case
Follow previously stated safety precautions before cleaning the workstation.

To clean the workstation case:

• To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.
• For stronger stains, use a mild dish-washing liquid diluted with water. Rinse well by wiping it with a cloth or swab 

dampened with clear water.
• For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will evaporate quickly 

and not leave a residue.
• After cleaning, always wipe the unit with a clean, lint-free cloth.
• Occasionally clean the air vents on the workstation. Lint and other foreign matter can block the vents and limit 

the airflow.

F.4 Cleaning the Keyboard
Follow all safety precautions stated earlier before cleaning the keyboard.

CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the keys. 

• Visible debris underneath or between the keys can be removed by vacuuming or shaking.
• Canned, pressurized air can be used to clean debris from under the keys. Caution should be used as too much 

air pressure can dislodge lubricants applied under the wide keys.
• If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool is available 

through many electronic supply outlets.

CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these keys are improperly 
removed or installed, the keyboard might not function properly.

• Cleaning under a key can be done with a swab moistened with isopropyl alcohol and squeezed out. Be careful 
not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any fibers or dirt in 
confined areas. Allow the parts to air dry before reassembly.

F.5 Cleaning the Monitor
Follow all safety precautions stated earlier before cleaning the monitor.

To clean the monitor, wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for 
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid might seep into the housing and 
damage a component. Never use solvents or flammable liquids on the monitor.
Routine Care144
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F.6 Cleaning the Mouse
Follow all safety precautions stated earlier before cleaning the mouse.

To clean the mouse:

• Clean the mouse ball by first removing the retaining plate and the ball from the housing. 
• Pull out any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.
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G Additional Password Security and Resetting CMOS
This workstation supports security password features, which can be established through the Computer Setup Security 
menu. These features are:

• setup password
• power-on password

When both passwords are set, the setup password can also be used in place of the power-on password as an override 
to log in to the workstation. This is a useful feature for a network administrator.

If you forget the password for the computer, there are two methods for clearing that password so you can gain access 
to the information on the workstation.

• resetting the password jumper
• using the Clear CMOS button

CAUTION: Pushing the CMOS button resets CMOS values to factory defaults and erases any customized information 
including passwords, asset numbers, and special settings. It is important to back up the workstation CMOS settings 
before resetting them in case they are needed later. To back up the CMOS settings, use Computer Setup and run the 
Save to Diskette option from the File menu.
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G.1 Resetting the Password Jumper
To disable the power-on or setup password features and clear the power-on and setup passwords:

1. Shut down the operating system and then turn off the workstation and any external devices. Disconnect the power 
cord of the workstation and any external devices from the power outlets.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to disconnect the 
power cord from the wall outlet and allow the internal system components to cool before touching.

CAUTION: When the workstation is plugged in, the power supply always has voltage applied to the system board 
even when the unit is turned off. Failure to disconnect the power cord can result in damage to the system.

CAUTION: Static electricity can damage the electronic components of the workstation or optional equipment. Before 
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a grounded metal 
object.

2. Open the access panel.
3. Locate the password header and jumper. The password header is E49.

NOTE: The password jumper is green so that it can be easily identified. For assistance locating the password jumper 
and other system board components, refer to “System Board” on page 55.

4. Remove the jumper. Place the jumper on either pin 1 or 2 (not both).
5. Replace the access panel.
6. Plug in the workstation and turn on the power. Allow the operating system to start. This clears the current 

passwords and disables the password features.
7. To establish new passwords, repeat steps 1 through 3, replace the password jumper on both pins 1 and 2, then 

repeat steps 5 through 7. Establish the new passwords in Computer Setup.

G.2 Clearing and Resetting the CMOS
The CMOS of the workstation stores password information and information about the workstation configuration. This 
section describes the steps to successfully clear and reset the CMOS.

G.2.1 Using Computer Setup to Reset CMOS
To reset CMOS using Computer Setup, access the Computer Setup Utilities menu. When the Computer Setup message 
appears in the lower-right corner of the screen, press the F10 key. Press Enter to bypass the title screen, if necessary.

NOTE: If you do not press the F10 key while the message is displayed, the workstation must be restarted to access the 
utility.

From the Computer Setup menu, select File > Set Defaults and Exit. This restores the soft settings that include boot 
sequence order and other factory settings. It does not, however, force hardware rediscovery.

NOTE: The workstation passwords and any special configurations along with the system date and time will have to be 
reset.

G.2.2 Using the CMOS Button

CAUTION: Pushing the CMOS button resets CMOS values to factory defaults and erases any customized information 
including passwords, asset numbers, and special settings. It is important to back up the workstation CMOS settings 
before resetting them in case they are needed later. To back up the CMOS settings, use Computer Setup and run the 
Save to Diskette option from the File menu.

1. Shut down the operating system and then turn off the workstation and any external devices. Disconnect the power 
cord of the workstation and any external devices from the power outlets. The CMOS will not clear if the 
workstation remains connected to a power outlet.

WARNING! To reduce the risk of personal injury from electrical shock and hot surfaces, be sure to disconnect the 
power cord from the wall outlet and allow the internal system components to cool before touching.
Additional Password Security and Resetting CMOS148
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CAUTION: When the workstation is plugged in, the power supply always has voltage applied to the system board 
even when the unit is turned off. Failure to disconnect the power cord can result in damage to the system.

CAUTION: Static electricity can damage the electronic components of the workstation or optional equipment. Before 
beginning these procedures, be sure that you are discharged of static electricity by briefly touching a grounded metal 
object.

2. Open the access panel.
3. Locate, press, and hold the CMOS button in for five seconds.

NOTE: For assistance locating the CMOS button and other system board components, refer to “System Board” on 
page 55.

4. Replace the access panel.
5. Plug in the workstation power and turn the power back on.

NOTE: The workstation passwords and any special configurations along with the system date and time will have to be 
reset.
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H Quick Troubleshooting Flows
This appendix presents some quick troubleshooting flowcharts for some common issues.

NOTE: The flowcharts presented here are for general troubleshooting purposes only and they might not apply to your 
specific workstation.

• Section H.1 “Initial Troubleshooting”
• Section H.2 “No Power”
• Section H.3 “No Video”
• Section H.4 “Error Messages”
• Section H.5 “No OS Loading”
• Section H.6 “No OS Loading from Hard Drive”
• Section H.7 “No OS Loading from Diskette Drive”
• Section H.8 “No OS Loading from CD-ROM Drive”
• Section H.9 “No OS Loading from Network”
• Section H.10 “Non-functioning Device”
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H.1 Initial Troubleshooting
Quick Troubleshooting Flows152
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H.2 No Power

H.2.1 No Power, Part 1
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H.2.2 No Power, Part 2
Quick Troubleshooting Flows154
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H.2.3 No Power, Part 3
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H.3 No Video

H.3.1 No Video, Part 1
Quick Troubleshooting Flows156
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H.3.2 No Video, Part 2
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H.3.3 No Video, Part 3
Quick Troubleshooting Flows158
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H.4 Error Messages

H.4.1 Error Messages, Part 1 
159



H.4.2 Error Messages, Part 2
Quick Troubleshooting Flows160
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H.4.3 Error Messages, Part 3
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H.5 No OS Loading
Quick Troubleshooting Flows162
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H.6 No OS Loading from Hard Drive

H.6.1 No OS Loading from Hard Drive, Part 1
163



H.6.2 No OS Loading from Hard Drive, Part 2
Quick Troubleshooting Flows164
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H.6.3 No OS Loading from Hard Drive, Part 3
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H.7 No OS Loading from Diskette Drive
Quick Troubleshooting Flows166
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H.8 No OS Loading from CD-ROM Drive
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H.9 No OS Loading from Network
Quick Troubleshooting Flows168
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H.10 Non-functioning Device
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